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introduction to the teacher guide

A perfect guide for an ICT teacher is one that provides support to the teacher to engage the students 
in joyful learning. Information and Communication Technologies (ICTs) refer to the possibilities 
offered by the convergence of data processing techniques, electronic media, and telecommunications, 
a convergence that has become evident over the past few years. 
 ICTs are grouped under two categories: traditional and new. Traditional ICTs are radio, television, 
and fixed line telephones etc., which have been gradually ingrained in the daily habits and lives of 
people and communities. New ICTs consist of computers and specific data processing applications 
accessible through those computers (e-mail, Internet, Word processing, and other data processing 
applications). 
 New ICTs are now found on the development agenda of African countries like ethiopia, and 
strategies have been gradually implemented to integrate them into the development process. Many 
countries have initiated significant reforms in the telecommunications sector: privatizing companies, 
liberalizing and ending national monopolies in this sector. 
 This Teacher Guide will help the teachers to:
 l explain how Information and Communication Technology (ICT) has the potential to make a real 

improvement to teaching and learning in schools.
 l demonstrate a wide variety of ways in which ICT can be used to enhance learning, offering a 

fresh burst of inspiration for them i.e., the busy school teachers.
 l take a structured approach, ensuring that the students can be guided progressively through all 

the contents in order to achieve the required standards for achieving Qualified Teacher Status, 
and also to continue their development in ICT to an advanced level. 

 l analyze all the common ICT tools and explain how they can exploit these tools for effective 
learning.

 l explore how students can learn with ICT, how their skills develop, and how these skills can aid 
their learning.

 l provide a framework for planning, analyzing and evaluating teaching with ICT.
 l use Internet, educational trips and other aids to support classroom teaching.
 l prepare additional activities and assessments for the students.
 l offer a range of innovative tasks, resources and methods of assessment.
 l use key ideas, skills and techniques of ICT in other curriculum areas.
 The guide also provides some suggested websites that have additional content for the teacher. 
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INTRODUCTION 
TO ICT

(18 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l know the term data, information, technology and the sources of information;

 l understand the differences between computers of one generation from the other;

 l recognize the types of computers used today and their difference;

 l understand the computer system.

suggested lesson plan

Sub-units Number of 
Periods

1.1 overview of ICT 3

1.2 Generation of Computers 2

1.3 Types of Computers 2

1.4 Introduction to Data Representation 4

1.5 Computer System 7

structure of the unit

1.1 overview of ICT

In this sub-unit, we will learn about basic concepts 
of ICT in an attempt to overview it. The topics to 
be learnt are:

 l Data vs information

 l Technology

 l Information technology

 l Sources of information

unit 1   

 l Documentary sources

 r Primary documentary

 r Secondary documentary

 r Tertiary documentary

 l Non-documentary sources

1.2  Generation of Computers

In this sub-unit, we will learn about the five generations 
of computers. The topic to be learnt is:

 l First, Second, Third, Fourth, and Fifth 
generation

1.3 Types of Computers

In this sub-unit, we will learn about the types of 
computers. The topics to be learnt are:
 l Super, Mainframe, Mini, Micro, Desktop, Laptop 

and Palmtop

 l Characteristics of computer

1.4 Introduction to Data representation

In this sub-unit, we will have an introduction to data 
representation. The topics to be learnt are:
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	 l	 Number system (binary, octal, hexadecimal)
	 l	 Conversion of numbers from one number system 

to the other
	 l	 Computer coding system (BCD, ASCII, 

Unicode)

1.5	 Computer System

In this sub-unit, we will learn about computer system 
i.e., hardware and software. The topics to be learnt 
are:
	 l	 Hardware components
	 r	 Input devices
	 r	O utput devices
	 r	 System unit
	 r	 Secondary storage devices
	 n	 Compact disc CD
	 l	 Types of software
	 r	 Systems software
	 n	O perating system software
	 r	 Language software
	 n	 Low level language
	 n	 High level language
	 n	 Compilers and interpreters
	 r	O thers
	 n	 Program utilities
	 n	 Device drivers
	 l	 Applications software
	 r	 General purpose (e.g., Microsoft word)
	 r	 Specialty software (e.g., Peachtree)
	 r	E ntertainment software
	 r	E ducational software
	 l	 Features of Operating system
	 r	 Creating folders
	 r	 Copying files and folders
	 r	 Moving files and folders
	 r	 Rename files and folders
	 r	 Deleting files and folders
	 r	 Searching files and folders

	 r	 Customize computer desktop

review of the unit

	 l	Data is a collection of raw facts and figures or 
a raw input which when processed or arranged 
makes meaningful output.

	 l	Information is the data that is organized, 
meaningful and useful.

	 l	Technology is the usage and knowledge of tools, 
crafts, techniques, or systems, or methods of 
organizations.

	 l	Information Technology (IT) refers to anything 
related to computing technology, such as 
networking, hardware, software, the Internet, or 
the people that work with these technologies.

	 l	An information ‘source’ can be categorized by 
the type of information it contains. The types are 
primary, secondary and tertiary.

	 l	The computers that used vacuum tube circuits 
were called the First Generation Computers.

	 l	The computers that used transistors were called 
the Second Generation Computers.

	 l	The Third Generation Computers used Large 
Scale Integration (LSI) circuits for processing.

	 l	The computers that used Very Large Scale 
Integrated (VLSI) chips were called the Fourth 
Generation Computers.

	 l	Recent research has focused on developing 
“thinking computers”. These computers are 
called the Fifth Generation Computers. They 
would be able to work like humans do.

	 l	Super computers are the most powerful 
computers among digital computers.

	 l	Mainframe computers are designed to handle 
huge volumes of data and information.

	 l	Minicomputers are small general purpose 
computers, also called mid-range servers.

	 l	Microcomputers are also called Personal 
Computers (PCs). These are classified into 
desktops and portables.

	 l	The main characteristics of a computer are: speed, 
accuracy, reliability, storage capacity, versatility, 
reduction in manpower and reduction in paper 
work.

	 l		A digital computer works with binary number 
system.
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	 l	All the data that is entered into a computer 
is first converted into the binary form and                             
after processing, it is again converted to human 
readable form.

	 l	There are different types of number systems 
(binary, octal, hexadecimal) that are used  to 
represent data.

	 l	We can convert a number in one system to the 
other system by following rules  specified by the 
number system.

	 l	Some useful computer coding systems are BCD, 
ASCII and UNICODE.

	 l	A computer system consists of hardware 
components and software components.

	 l	Hardware are the physical parts of the computer 
that can be seen and touched.

	 l	Software are the sets of instructions that instruct 
the computer to do different tasks, for example: 
word processing, games, painting, e-mail, 
spreadsheets.

	 l	Software can be classified as systems and 
application software.

	 l	Operating system is a bridge between the 
computer hardware and the user.

Important facts and formulae, 
tables, charts, etc.

Conversion of Numbers from Decimal to 
Binary

There are two methods for converting (integers) from 
decimal to binary.

	 The first method of converting decimal to binary 
is repeated-division method. In this method, the 
number is successively divided by 2 until it becomes 0 
and its remainders recorded. The final binary result is 
obtained by assembling all the remainders, with the last 
remainder being the Most Significant Bit (MSB).  This 
method has been explained in the Student Textbook.

	 The second method requires a table of powers of 2 
as shown below:

n 2n

0 1

1 2

2 4

3 8

4 16

5 32

6 64

7 128

8 256

9 512

10 1024

11 2048

12 4096

13 8192

... ...

	 Because of this restriction, it is more useful for small 
numbers where these powers have been memorized. 
Starting with the decimal number to be converted, 
obtain the largest power of 2 i.e., 2n from the table 
without exceeding the given number. Record 1 at 
the (n + 1)th position (MSB). Then subtract the table 
obtained number from the original number. Repeat 
the process for the remainder, and continue until the 
remainder is 0. Fill 0s at those positions which have 
not been recorded with 1s. Finally read the binary 
digits i.e., bits to get the result.
	 Example 1. Convert 2310 to binary.
	 Solution. From the table, 16 is the largest number 
without exceeding 23.
	 24 = 16 i.e., put 1 at (4 + 1)th position (MSB).
		  5th	 4th	 3rd	 2nd	 1st
		  1			 
	 23 – 16 = 7
	 From the table, 4 is the largest number without 
exceeding 7.
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	 22 = 4 i.e., put 1 at (2 + 1)rd position.
		  5th	 4th	 3rd	 2nd	 1st
		  1		  1	
	 7 – 4 = 3
	 From the table, 2 is the largest number without 
exceeding 3.
	 21 = 2 i.e., put 1 at (1 + 1)nd position.
		  5th	 4th	 3rd	 2nd	 1st
		  1		  1	 1
	 3 – 2 = 1
	 From the table, 1 is the largest number without 
exceeding 1.
	 20 = 1 i.e., put 1 at (0 + 1)st position.
		  5th	 4th	 3rd	 2nd	 1st
		  1		  1	 1	 1
	 1 – 1 = 0
	 Now, the remainder is 0. Fill 0 at the 4th position, 
where 1 was not recorded. So, the various 1s and 0s 
obtained from the above process are as follows:
		  5th	 4th	 3rd	 2nd	 1st
		  1	 0	 1	 1	 1		
	 Thus, 2310 = 101112

	 Example 2. Convert 16710 to binary.
	 Solution. From the table, 128 is the largest number 
without exceeding 167.
	 27 = 128 i.e., put 1 at (7 + 1)th position (MSB).
		  8th	 7th	 6th	 5th	 4th	 3rd	 2nd	 1st
		  1		
	 167 – 128 = 39
	 From the table, 32 is the largest number without 
exceeding 39.
	 25 = 32 i.e., put 1 at (5 + 1)th position.
		  8th	 7th	 6th	 5th	 4th	 3rd	 2nd	 1st
		  1		  1
	 39 – 32 = 7
	 From the table, 4 is the largest number without 
exceeding 7.
	 22 = 4 i.e., put 1 at (2 + 1)rd position.
		  8th	 7th	 6th	 5th	 4th	 3rd	 2nd	 1st
		  1		  1			   1
	 7 – 4 = 3

	 From the table, 2 is the largest number without 
exceeding 3.
	 21 = 2 i.e., put 1 at the (1 + 1)nd position.
		  8th	 7th	 6th	 5th	 4th	 3rd	 2nd	 1st
		  1		  1			   1	 1
	 3 – 2 = 1
	 From the table, 1 is the largest number without 
exceeding 1.
	 20 = 1 i.e., put 1 at (0 + 1)st position.
		  8th	 7th	 6th	 5th	 4th	 3rd	 2nd	 1st
		  1		  1			   1	 1	 1
	 1 – 1 = 0.
	 Now, the remainder is 0. Fill 0s at the 7th, 5th 
and 4th positions, where 1 was not recorded. So, the 
various 1s and 0s obtained from the above process are 
shown below:
		  8th	 7th	 6th	 5th	 4th	 3rd	 2nd	 1st
		  1	 0	 1	 0	 0	 1	 1	 1		
Thus, 16710 = 101001112

Role of the students

In this unit, the students are supposed to have an 
introduction to ICT. The activity based method should 
be followed to understand the subject matter which 
is the best way of better understanding of the subject 
matter.
	 ICT has the potential to transform learning in and 
beyond the classroom. Some of the perceived benefits 
to learners are:
	 l	 They can access enormous amounts of information 

quickly;
	 l	 They can work at their own pace;
	 l	 Special needs, both remedial and extension, can 

be offered during the same lesson;
	 l	 Course material can be offered simultaneously 

in different languages;
	 l	 They can access quality material irrespective of 

their geographical location;

	 l	 Academic courses can be offered 
asynchronously;
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	 l	 ICT offers a host of different tools to demonstrate 
learning, suitable for divergent and different 
intelligences; and,

	 l	 Young students can easily accept the 
technology.

	 l	 They can interact with peers and experts outside 
the classroom, town, and/or country;

	 l	 ICT can offer simulations where the student can 
experiment by changing the variables;

additional class activities for gifted students or slow learners

  ACTIVITY 1.1: Uses of Computers in the Educational Field

Students in their class will explain and discuss the uses of computers in the field of education.
	 Computers are an excellent way to make a class more exciting even though it can never take the teacher 
place. Computers are everywhere and you will be expected to have computer skills for any job that you go 
into after completion of your study. 

Fig. 1.1: Students learning on a Computer

Computers in the Educational Field
Computers are used in a variety of settings within the educational field. They can be used by guidance 
counselors, administrators, web masters, library media specialists, students, teachers and clerical workers 
for many different reasons. Computers lend an organizational hand to schools, and they also improve 
productivity in several areas. For these reasons, computer technology has become an essential part of the 
educational system.

Clerical Staff 
Educational clerical staff members use computers to store and maintain student records at various levels. 

Guidance Counselors and Social Workers
Guidance counselors and school social workers use computer technology to communicate with teachers and 
parents, and they also use technology to keep and monitor student records. 

Administrators
School administrators use computers to communicate electronically (e.g., e-mails) with other staff members 
and parents, and they also use computers to generate letters and documents for parents, staff and education 
department.

Webmasters
Computers are also used in schools in order to maintain websites. School webmasters upload important 
documents to electronic document files, update calendars and important school information and provide 
helpful links to parents and teachers.
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Library Media Specialists
School library media specialists use computer technology to catalogue books and keep student checkout 
records. Additionally, many school libraries maintain websites that serve as portals for their student 
populations.

Teachers
Teachers use computers for a variety of reasons. They use computers to keep electronic grade books; maintain 
and update personal websites to share information with families; communicate with other teachers, parents 
and administrators and use software to create classroom newsletters. 

Students
In schools, students use computers to learn both with and from technology. Computers enable students to 
research a variety of subjects. Students can also use computers to view assignment guidelines and requirements 
at home and communicate with teachers about assignments.

  Activity 1.2: Binary Code

Students in their class will explain and discuss the binary code inside the computers.
	 Do you know that all of the information that travels through your computer is based on two commands? It 
is true. The only data that a computer can understand is on  and off . But, the millions of combinations of 
those two commands given in series are what make a computer work. Let us have an idea of binary code.

Binary Code
Do you remember the power supply that is inside your computer and how it 
sends electricity to all of the components? That electricity is what creates an 
on signal. The memory chips inside your computer are divided into thousands 
of tiny compartments called bits. Each bit has an electronic switch or gate. 
On means the gate is open and letting electricity go through. The computer 
reads on or  open switches as a number 1. Closed gates are off  because 
the electricity is blocked and cannot get through. The computer reads off  bits  
as 0. It is by grouping these bits together to form a series of 1/0 commands, that 
data is formed. Eight bits are grouped together to form a byte. In this group of 
eight, there are 256 possible combinations of 1/0. The grouping of 1/0 within a 
byte is called Binary Code.
	 For example, when you type the letter A on your keyboard, electrical signals 
are sent from the keyboard to the CPU. The CPU turns the signals into binary 
code. Then, the computer reads the code and sends it on to the monitor to 
display the letter A (see Fig. 1.3).

Fig. 1.2: Binary code

Fig. 1.3: Conversion of a letter 
into binary code and back

Answers to textbook assessments

	 3.	 Technology
	 4.	 primary, secondary, tertiary

State Whether True or False

	 1.	 False	 2.	 True	 3.	 True	 4.	 True

Assessment 1.1

Fill in the Blanks

	 1.	 Information and Communication Technology
	 2.	 Data
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Answer the Following

	 1.	 Data: The term data refers to any raw collection 
of facts and figures that does not convey any 
meaning. Data serves as a raw material for 
obtaining the information. For example, collecting 
the data of names, ages and marks of students.

		  Information: Information is the processed form 
of data i.e., something obtained after applying a 
process on raw material. For example, we can 
extract various information about the marks, 
names and ages of students from the student 
table.

	 2.	 The differences between data and information 
are given below:

Data Information

It is a collection of facts 
and figures.

It is a collection of final 
results.

It is in an unorganized 
(raw) form.

It is in an organized form.

It is not in directly useful 
form.

It is in directly useful 
form.

It needs processing. It does not need any 
processing.

It is also termed as input. It is also termed as output.

It requires observations and 
recordings.

It requires analysis.

	 3.	 Technology: Technology is the usage and 
knowledge of tools, crafts, techniques, or systems, 
or methods of organizations.

		  Nowadays, technology is an integrated part 
of lives of human beings. For example, the 
technology in communications such as mobile 
phones help us to connect with the other people 
easily.

		  Information Technology: Information Technology 
or “IT”, refers to anything related to computing 
technology, such as networking, hardware, 
software, the Internet, or the people that work 
with these technologies.

		  Information Technology uses computers, 
servers, database management systems and 
cryptography.

	 4.	 The different sources of information are discussed 
below:

		  Primary Documentary
		  Primary documentary sources  of information 

are  original materials  that often convey new 
ideas, discoveries, or information. These sources 
originate from the time period under study. 
Examples of primary sources include:

	 (i)	 original research studies (often in the 
form of journal articles in peer-reviewed 
publications), also called empirical studies 
(e.g., psychology)

	 (ii)	 patents, technical reports
	 (iii)	 original documents such as diaries, letters, 

e-mails, manuscripts, lab data/notes
	 (iv)	 newspaper articles from the time period 

under study
	 (v)	 autobiographies, first-person accounts, case 

studies
	 (vi)	 artifacts and archival material such as official 

documents, minutes recorded by government 
agencies and organizations, photographs, 
coins, fossils, natural specimens

	 (vii)	 works of art such as literature, music, 
architecture, or paintings.

		  Secondary Documentary
		  Secondary documentary sources  of information 

are based on primary sources. They are generally 
written at a later date and provide some 
discussion, analysis, or interpretation of the 
original primary source. Examples of secondary 
sources include:

	 (i)	 review articles or analyses of research studies 
about the same topic (also often in peer-
reviewed publications)

	 (ii)	 analyses of original documents or archival 
material

	 (iii)	 biographies, reviews, or critiques of an 
author.

		  Tertiary Documentary
		  Tertiary documentary sources  of information 

are  based on a collection of primary and secondary 
sources. Examples of tertiary sources include:

	 (i)	 textbooks (sometimes considered as secondary 
sources)
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	 (ii)	 dictionaries and encyclopaedias 
	 (iii)	 manuals, guidebooks, directories, almanacs
	 (iv)	 indexes and bibliographies.
		  Non-documentary Sources
		  The non-documentary sources of information 

are also called Informal Information Sources. 
These include government departments, research 
organizations, learned professional societies, 
industries, universities, colleagues, corridor 
meetings at conferences and social gatherings. 
Examples of non-documentary sources are small 
groups, big groups, Blogs and Twitters etc.

Suggested Activities

	 Refer to sub-unit 1.1 of the Student Textbook for 
doing the activities.

Assessment 1.2

Fill in the Blanks

	 1.	 five	 2.	 cost, size
	 3.	 vacuum tube	 4.	 Fifth

State Whether True or False

	 1.	 True	 2.	 False	 3.	 True	 4.	 True

Answer the Following

	 1.	 The generation of computers are given below:
	 (i)	 First Generation (1940–1956)
	 (ii)	 Second Generation (1956–1964)
	 (iii)	 Third Generation (1964–1971)
	 (iv)	 Fourth Generation (1971-present)
	 (v)	 Fifth Generation (Future)
	 2.	 The comparison of various generations of 

computers is given in the following table:
Comparison of Generations of Computers

Generation Period Circuitry Input Storage Output Language Examples

First 1940–56 Vacuum Tubes Punched Cards Magnetic 
tapes

Punch 
Cards

Machine 
Language

Univac, 
IBM 650, 

Burroughs 200
Second 1956–64 Transistors Punched 

Cards, 
Magnetic tapes

Magnetic 
tapes

Punch 
Cards

Machine, 
Assembly

IBM 1400, 
Honeywell 200

Third 1964–71 Integrated 
Circuits (ICs)

Keyboards Magnetic 
Disks

Monitor Pascal, 
Fortran, 

Cobol, RPG

IBM System- 
360

Fourth 1971-
present

Very Large Scale 
Integration 

(VLSI) 
of circuits

Mouse, 
Scanners, 

Sound, etc.

Magnetic 
Disks with 

higher 
capacity

Monitor, 
Printers

RDBMS, 
etc.

IBM System 
3760, HP 3000

Fifth Future With Artificial 
intelligence

Suggested Activity

  Activity 1:	 Explain and Demonstrate (Pictorially or Physically) each Generation of 
Computers

Students in their class will explain and demonstrate the five generations of computers pictorially.

Evolution of Computers

While it would not be wrong to say that the evolution of the computer began with the man’s need to count, the 
actual growth of this field happened in a short span of thirty years. This rapid development was characterized 
by phases of growth, which have come to be called computer generations. Major technological developments 
in each generation led to smaller, cheaper, more powerful, more efficient and reliable computers.
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Five Generations of Computers

The five generations of computers are explained and demonstrated below:
First Generation (1940–1956): Vacuum Tubes
The first generation computers used valves leading to huge size and cost. 
The UNIVAC and ENIAC computers are examples of first-generation 
computing devices. The UNIVAC was the first commercial computer 
delivered to a business client, the U.S. Census Bureau in 1951.
Second Generation (1956–1964): Transistors
The second generation computers used transistors. In span of ten years, transistors that were more efficient 
and cheaper replaced valves.

Fig. 1.5: Second Generation Computer

Third Generation (1964–1971): Integrated Circuits
The third generation computers used Integrated Circuits (ICs). In the early sixties, 
a major breakthrough was achieved when hundreds of transistors could be placed 
on single silicon chip. This Integrated Chip (IC) became the basis of the Third 
Generation.
Fourth Generation (1971–Present): Microprocessors
The fourth generation computers used microprocessors. With the introduction of VLSI (Very Large Scale 
Integration), thousands of transistors could be placed on a single chip. In 1981, IBM introduced its first computer 
for the home user, and in 1984, Apple introduced the Macintosh. Fourth generation computers also saw the 
development of Graphical User Interfaces (GUIs), the mouse and handheld devices. 

   
Fig. 1.7: Fourth Generation Computers

Fifth Generation (Present and beyond): Artificial Intelligence
The fifth generation computer tries to infuse artificial intelligence into computers. The development of 
these computers is still in its infancy, but examples can be cited of various speech recognition systems and 
robots.

Fig. 1.8: Fifth Generation Computer

Fig. 1.4: First Generation Computer

Fig. 1.6: Third Generation 
Computer
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Assessment 1.3

Fill in the Blanks

	 1.	 Computers	 2.	 Super computers
	 3.	 Desktops	 4.	 pocket calculator

State Whether True or False

	 1.	 False	 2.	 True	 3.	 False	 4.	 True

Answer the Following

	 1.	 The various types of computers used today are 
classified as:

	 (i)	 Super computers
	 (ii)	 Mainframe computers
	 (iii)	 Minicomputers
	 (iv)	 Microcomputers
	 (a)	Desktop
	 (b)	Laptop
	 (c)	Palmtop
	 2.	 The characteristics of each type of computer are 

given below:
	 (i)	 Speed: Computers work at an amazing speed 

without any mistakes. The work, which a 
normal person would complete in a few hours 
can be done within fractions of a second by 
a computer. Speed of computers is measured 
in terms of milliseconds (10–3 seconds), 
microseconds (10–6 seconds) or nanoseconds 
(10–9 seconds).

	 (ii)	 Accuracy: A computer performs its task with 
great accuracy. It never commits mistakes in 
processing the data. It produces errors when 
we enter inaccurate input, i.e., Garbage In 
Garbage Out (GIGO).

	 (iii)	 Reliability: Computers are more reliable than 
human beings as they do not get bored of the 
repetitive tasks and never get tired.

	 (iv)	 Storage Capacity: A computer can store large 
amount of data. It can store various documents, 
articles, pictures, etc., in its memory which 
can be used whenever required. On the other 
hand, a human being can keep only a limited 
information in his/her mind and rest of the 
things, he/she forgets.

	 (v)	 Versatility: A computer can perform various 
types of jobs. On a computer system, we 

can listen to songs while typing text or play 
games while working on any other package, 
do calculations, make drawings, surf the net, 
send e-mail, etc.

	 (vi)	 Reduction in Manpower: Earlier, the work in 
industries/factories was done by a number 
of persons. But with computers, it can be 
completed by a few persons and that too 
more accurately and efficiently. The advent 
of computer has reduced the need of 
manpower.

	 (vii)	 Paper Work can be Reduced: The use of 
computer reduces the burden of paper work 
in any organization. For example, record of 
each student of a school can be kept in the 
computer itself rather than keeping manual 
files for each student. Also, information 
regarding any student can be obtained easily 
and quickly with the help of a computer.

Suggested Activity

	 Refer to sub-unit 1.3 of the Student Textbook for 
doing the activity.

Assessment 1.4

Fill in the Blanks

	 1.	 binary	 2.	byte
	 3.	 1024
	 4.	 American Standard Code for Information 

Interchange.

State Whether True or False

	 1.	 False	 2.	 True	 3.	 True	 4.	 False

Answer the Following

	 1.	 A computer handles non-numeric data in addition 
to numeric data, that is, alphabets, punctuation 
marks and other special characters. Some predefined 
codes are used to represent the numeric and non-
numeric characters. These codes are known as 
alphanumeric codes. Any data or information is 
represented internally using the bits 0 and 1.

		  The various codes for data representation are: 
BCD, ASCII and UNICODE, etc. All the data that 
is entered into a computer is first converted into 
the binary form and after processing, it is again 
converted to human readable form.
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	 2.	 The number systems are discussed in brief as:
		  Binary Number System: It consists of two digits 

namely 0 and 1. These binary digits are called 
bits. The base or radix of binary number system is 
2 as it uses two digits only. It may be noted that 
the base digit namely 2, is not the fundamental or 
basic digit of the system. Thus, all the numbers in 
binary system are written with the help of these 
two digits namely, 0 and 1. The positional value 
or place value of each digit in a binary number 
is twice the positional value of the digit on its 
right. This number system is identical to decimal 
number system with the base replaced by 2. For 
example, (1011)2. Binary number system is used 
by the computers.

		  Octal Number System: It has base or radix 8. The 
basic digits of this system are 0, 1, 2, 3, 4, 5, 6 
and 7. It may be noted that the base 8 is not the 
basic digit of the system. It is commonly used as 
a shorthand way of expressing binary quantities. 
Also the numbers represented in octal number 
system can be used directly for input and output 
operations.

		  The octal number system is also a positional 
value system, wherein each octal digit has its 
own value or weight expressed as a power of 8. 
For example, (517)8.

		  Hexadecimal Number System: It is popularly known 
as Hex System. It consists of sixteen symbols and 
therefore has the base or radix as 16 or H. It is very 
well suited for big computers. The hexadecimal 
number system represents the data/information 
in the concise form. The sixteen symbols used in 
this system are:

		  0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F.
		  It is also positional value system, wherein each 

hexadecimal digit/letter has its own value or 
weight expressed as a power of 16. For example 
(1C)16.

	 3.	 (i)		  (101011)2	 =	 ?10

				    =	 1 × 20 + 1 × 21 + 0 × 22 + 
1 × 23 + 0 × 24 + 1 × 25

		  		  =	 1 + 2 + 0 + 8 + 0 + 32
				    =	 43
		  Therefore, (101011)2 = (43)10

	 (ii)		  (25)10	 =	 ( )2

2 25 Remainder

2 12 1

2 6 0

2 3 0 = 11001

2 1 1

0 1

		  Therefore, (25)10 = (11001)2

	 (iii)		  (759)10	 =	 ( )8

8 759 Remainder

8 94 7

8 11 6 = 1367

8 1 3

0 1

		  Therefore, (759)10 = (1367)8

	 (iv)		  (746)8	 =	  ( )2

			   (746)8	 =	 7	 4	 6
					     111	 100	 110
		  as	 111	 =	 7, 100 = 4 and 110 = 6 
				    in decimal
		  Therefore, (746)8 = (111 100 110)2

	 (v)		  (59F)16	 =	 ( )2

			   5	 =	 (0101)2

			   9	 =	 (1001)2

			   F	 =	 (1111)2

		  Therefore, (59F)16 = (101 1001 1111)2

	 (vi)		  (9D)16	 =	 ( )10

				    =	 13 × 160 + 9 × 161

(Here, D = 13)
				    =	 13 + 144
				    =	 157
		  Therefore, (9D)16 = (157)10

	 (vii)		  (11101)2	 =	 ( )8

				    =	 011 101	 (0 added to the
	 left to complete the group)
	 	 	 	 =	 3  5
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		  as	 011	 =	 1 × 20 + 1 × 21 + 0 × 22

				    =	 1 + 2 + 0 = 3
		  and	 101	 =	 1 × 20 + 0 × 21 + 1 × 22

				    =	 1 + 0 + 4
				    =	 5
		  Therefore, (11101)2 = (35)8

	 (viii)		  (47)8	 =	 ( )10

				    =	 7 × 80 + 4 × 81

				    =	 7 + 32
				    =	 39
		  Therefore, (47)8 = (39)10

	 (ix)		  (79)10	 =	 ( )16

Remainder
Hexadecimal 

equivalent16 79

16 4 15 F = 4F

0 4 4

		  Therefore, (79)10 = (4F)16

	 4.	(i)	 BCD: Binary Coded Decimal (BCD) code is one 
of the early computer codes. The idea of this 
coding scheme is to convert each digit of a 
decimal number into its binary equivalent 
instead of converting the entire decimal 
value into a binary number. This makes the 
conversion process easier. All the decimal 
digits are represented in BCD by 4 bits. For 
example,

			   1210	 =	 1
0001

2
0010

			  or 0001 0010 in BCD
		  Computer designers commonly use six bits to 

represent BCD code. With six bits, it is possible 
to represent 64 (26) different characters. For 
example,

		  In BCD notation:
	 	 	 I	 =	 111001 C = 110011
			   T	 =	 010011
		  Hence, the binary digits

		  I
111001

C
110011

T
010011

		  will record the word ICT in BCD.
	 (ii)	 ASCII: Pronounced “ask-ee”, ASCII (American 

Standard Code for Information Interchange) 
is the binary code most widely used with 

microcomputers. It has replaced many of the 
special codes that were previously used by 
computer manufacturers.

		  ASCII 7-bit code can represent up to 128 
characters. A letter, digit or special symbol is 
called a character. It includes upper-case and 
lower-case alphabets, numbers, punctuation 
marks, special characters and control 
characters.

		  ASCII 8-bit code can represent up to 256 
characters.

	 (iii)	 UNIcode : Unicode uses two bytes  
(16 bits) for each character. It can handle 
65,536 character combinations. Thus, it allows 
almost all the written languages of the world 
to be represented using a single character set. 
Formally,

			  Unicode provides a unique number for every 
character,

			   no matter what the platform,
			   no matter what the program,
			   no matter what the language.
	 	 Unicode standard covers the principal written 

languages of the America, Europe, the Middle 
East, Africa, India and Asia.

Suggested Activity
	 Refer to sub-unit 1.4 of the Student Textbook for 

doing the activity.

Answers to Review Questions

Fill in the Blanks
	 1.	 computer	 2.	 CD, DVD
	 3.	 System	 4.	 Device drivers

State Whether True or False
	 1.	 False	 2.	 True	 3.	 True	 4.	 False

Multiple Choice Questions
	 1.	 (b)	 2.	 (d)	 3.	 (a)	 4.	 (c)

Match the Following
	 1.	 (d)	 2.	 (f)	 3.	 (e)	 4.	 (i)
	 5.	 (h)	 6.	 (b)	 7.	 (c)	 8.	 (g)

Answer the Following
	 1.	 Computer System: A computer is an electronic 

device that can accept data and instructions, store 
and process it to produce the required result.
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		  The computer mainly consists of hardware 
and software components. Both of these work 
together to process data. Figure 1.9 illustrates 
these two components:

Fig. 1.9: Hardware and Software

		  Hardware consists of all machinery and equipment 
in a computer system. Hardware runs under the 
control of software and is useless without it. 
However, hardware contains the circuitry that 
allows processing.

		  The hardware components are: input devices, 
output devices and system unit. Software also 
called programs are step-by-step electronically 
encoded instructions that tell the computer how 
to perform a task. Without software, hardware is 
useless.

		  Software is divided into two main categories: 
System software and Application software.

	 2.	 The major hardware components of a computer 
system are listed below:

		  Input Devices: Keyboard and mouse.
		  Output Devices: Monitor, printer and sound 

speakers.
		  System Unit: CPU, memory chips, motherboard 

and some secondary storage devices—floppy-

disk drive, hard-disk drive and CD or DVD 
drive.

	 3.	 System Software: Software that helps the 
computer perform essential operating tasks. 
It consists of several programs. The most 
important is the operating system, the 
master program that runs the computer.  
For example, Windows XP, Windows 7, Unix, 
Linux and the Macintosh operating system.

		  Application software cannot run without system 
software.

		  Application Software: Software that has been 
developed to solve a particular problem, perform 
useful work on general-purpose tasks, or provide 
entertainment.

		  Application software such as word processing, 
spreadsheet, presentation, desktop publishing, 
database management, graphics and 
communications packages are commonly used 
tools for increasing user’s productivity.

	 4.	O perating system is the master control program 
that runs the computer. For example, Windows 
XP. The features of an operating system are:

	 (i)	 Manipulates the files and folders on a 
computer.

	 (ii)	 Transfers files from one folder to another.
	 (iii)	 Finds a file or folders using a ‘search’ 

facility.

	 (iv)	 Customizes the computer desktop.

Suggested Activities

Refer to sub-unit 1.5 of the Student Texbook for doing Activity 2

  Activity 1:	 Demonstrate and Explain in Brief a Computer System

Students in their class will demonstrate and explain in brief a computer system.

Computer

A computer is an electronic device that can accept, store and process data under the control of set of instructions 
(see Fig. 1.10).

Fig. 1.10: A computer system
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As computer pioneer John Von Neumann has said, the device should not be called the computer but rather 
the “all-purpose machine”. It is not just a calculating machine but it can be put to any number of uses.
The computer mainly consists of hardware and software components. Both of these work together to process 
data.
Hardware
It refers to the devices you can physically see and touch in and on the computer. The hardware components 
are:
Input Devices: These allow people to put data into the computer in a form that the computer can use, for 
example, keyboard, mouse, and microphone (see Fig. 1.11).

	 	 	

	 Keyboard	 Mouse	 Microphone
Fig. 1.11: Input devices

Output Devices: These translate information processed by the computer into a form that humans can 
understand—print, sound, graphics or video. For example, monitor, printer, sound speakers and headphone 
(see Fig. 1.12).

	 	 	 	

	 Monitor	 Printer	 Sound	 Headphone
			   speakers

		  Fig. 1.12: Output devices

System Unit: It is also known as case. It is the box that houses the CPU, the memory chips and the motherboard 
with power supply, as well as some secondary storage devices—floppy-disk drive, hard-disk drive and CD 
or DVD drive (see Fig. 1.13).

Fig. 1.13: Case or system cabinet

Software
It refers to the operating instructions and applications that allow computers to process the numbers, pictures, 
sounds and text we enter into them. Software is generally divided into two main categories: System software 
and Application software. The system software are generally concerned with the various operations of a 
computer system and the application software are concerned with provided services to the users. For example, 
Windows XP, Microsoft Word 2007, etc.
	 We can touch the disk that contains the software, but not the lines of programming code that make up the 
software.
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 Useful Tip

To identify the processor, clock speed and amount of RAM (Random Access Memory) in a computer system 
having Windows XP operating system:
	 Click Start → Control Panel → Performance and Maintenance System

Alternative Teaching Approaches, 
Enrichment Material

The ICT teachers can use Internet, charts, models, 
worksheets, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning ICT.

Additional Questions

	 1.	 What is the relation between data and 
information?

	 2.	 List sources of information.

	 3.	 What is information? What are its features?
	 4.	 Write the name of the dominating circuit element 

of each generation of computers.
	 5.	 What are the bases of decimal, octal, binary and 

hexadecimal number systems?
	 6.	 What is the difference between hardware and 

software?
	 7.	 What are the main types of software? Explain 

with appropriate examples.
	 8.	 Write short note on the following:
	 (i)	 Utility Software
	 (ii)	 Device drivers.
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APPLICATION 
SOFTWARE

(15 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l understand how to open word processing software, and create, and save a document;

 l recognize how to format a document in a desired way;

 l apply any of formatting features in their document;

 l understand how to open presentation software, and create and save a document;

 l recognize how to create a slide show using animation and sound.

suggested lesson plan

Sub-units Number of 
Periods

2.1 Word Processor 8

2.2 Presentation Software and 
Techniques

7

structure of the unit

2.1 word Processor

In this sub-unit, we will learn about basics of Word 
Processor. The topics to be learnt are:
 l open word processor
 l Creating new document
 l Saving a document
 l Closing a document
 l editing a document
 l Formatting a document
 	 Character	formatt	ing
 	 Paragraph	formatt	ing
 	 Page	formatt	ing

unit 2   

  Spell checking
  Inserting tables
  Inserting pictures (clipart, drawing object)

2.2 Presentation Software and Techniques

In this sub-unit, we will learn about basics of 
Presentation Software and Techniques. The topics 
to be learnt are:
 l Features of a presentation package
 l Creating slides using text and images
 l Formatting text and background
 l Inserting and deleting slides
 l Presenting a slide show
 l Create a slide show using animation and sound
 l Change slide layout

review of the unit

 l	Word processing software allows to create, edit, 
format, print and store text material.

	 l	MS-Word is a Windows based application.
	 l	A file created using MS-Word is known as a 

document.
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	 l	Text can be entered anywhere in a document 
area by placing the cursor at that place.

	 l	The Undo option is used to undo the previous 
action and the Redo option will repeat the 
previous Undo action.

	 l	Formatting means changing the appearance of 
text.

	 l	Presentation software is a tool used to create 
visual presentations.

	 l	A presentation package helps both: the speaker 
with an easier access to his/her ideas and the 
participants with visual information.

	 l	We can make slides using features such as creating 
slides, inserting text, formatting text, inserting 
clipart, formatting background, inserting slides, 
deleting slides and inserting images from other 
files.

	 l	Presenting a slide show is the most useful view 
of PowerPoint. It is used to display the slides in 
a desired sequence.

	 l	The slide layout in PowerPoint is the arrangement 
of all the items that make up your slide, such as 
title, graphics or text boxes.

ROLE OF THE STUDENTS
In this unit, the students are supposed to learn the basic 
concepts of Word Processing, Presentation Software 
and Techniques. The activity-based method should be 
followed by understanding the subject matter which 
is the best way of better understanding of the subject 
matter.
	 Different type of technologies can be used by the 
students to support and enhance learning. There are 
many resources which can help schools to plan for 
technology that will have a positive impact on student 
achievement. Various technologies deliver different 
kinds of content and serve different purposes in the 
classroom. For example, word processing promotes 
communication skills and presentation software 
promotes presentation skills of students. So, it is 
important to consider how these electronic technologies 
differ and what characteristics make them important 
as vehicles for learning ICT.

ADDITIONAL CLASS ACTIVITIES FOR GIFTED STUDENTS OR SLOW LEARNERS

ACTIVITY 2.1: Create a Calendar Using MS-Word 2007

Students in groups will create a calendar using MS-Word 2007 and present it in their class.
	 Calendars help the students stay on top of project schedules, important school dates, and daily 
planning. Curriculum-related calendars include “This Day in History,” temperature or weather 
calendars (daily, weekly, or monthly logs), weekly spelling words, and vocabulary challenges for each 
week of a month. 
	 To create a calendar using MS-Word 2007, perform the following steps:

	 1.	O pen MS-Word 2007.
	 2.	 Click the Office Button. A menu appears.
	 3.	 Click New.
	 4.	 In Templates, under Microsoft Office Online, click Calendars. Search online to find the largest variety of 

calendar templates. You may also find calendar templates in Installed Templates.
	 5.	 Now, in the center pane, you can: 
	 (i)	 Click a calendar category to view thumbnails.
	 (ii)	 Click a thumbnail to view details in the right pane.
	 (iii)	 Click the arrows at the top of the pane to navigate between levels.
	 6.	 When you find a calendar you want to use, in the right pane, click Download (see Fig. 2.1). The template 

is downloaded to your computer and opens in a new document.
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Fig. 2.1: Clicking download

	 7.	 The calendar looks finished, but you can customize any part of it to fit your needs. If you click the 
template, you will see that it is built from basic MS-Word 2007 objects, like text boxes, shapes, and 
tables. Figure 2.2 shows part of a downloaded calendar. To modify a part of the calendar, select the 
object and use the options in the tabs that open in the ribbon, or type new text. You can also click 
the Insert tab and add objects, like pictures and SmartArt.

	 8.	 You can leave your calendar blank or add your own important information, such as a school event, 
a holiday, or project details.

	 9.	 When you finish, click the Office Button and then click the Save button. You can save the calendar as 
a document. Or if you want to create more documents based on the calendar, click Save as type in 
the Save As dialog box and then select Word Template (.dotx). Enter a File name, and click OK.

Fig. 2.2: Part of a downloaded calendar
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Useful Tip
With the Calendar Wizard, you can create a calendar from scratch. Under Templates, click Calendars. In the 
center pane, click Other Calendars, click Calendar Wizard, and then click Download. A new document opens and 
the wizard starts. Move through the pages of the wizard, and select a style, the print orientation, whether to 
leave room for a picture, and a date range. The wizard is added to your Templates folder.

  Activity 2.2: Presenting a Slide Show

Students in groups will prepare presentations and demonstrate the slide show in the class.
	 First of all prepare a presentation on any given topic of your choice. You can add transitions (a transition 
is how one slide is removed from the screen during a presentation and the next slide is displayed) and 
sounds with options in the Animations tab. Here, we have prepared the presentation on “Ethiopian National 
Parks”.
	 To start the Slide Show, perform the following steps:

	 1.	 Start PowerPoint.
	 2.	 Click on Office Button. A menu appears.
	 3.	 Click New. Select the appropriate file name and press Enter key or Double-click on the file. The desired file 

will be opened.
	 4.	 Click the Slide Show tab.
	 5.	 Click the From Beginning icon in the Start Slide Show command group or press F5 key. PowerPoint displays 

the first slide of your presentation (see Fig. 2.3). 

Fig. 2.3:  Getting ready for presenting a Slide Show

	 6.	 Run the presentation by clicking the left mouse button at each slide. At the black screen, click the left 
mouse button again.

		  The slides in the presentation are shown in Fig. 2.4.
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	 Slide 1	 Slide 2

	 	
	 Slide 3	 Slide 4

	 	
	 Slide 5	 Slide 6

	 	
	 Slide 7	 Slide 8
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Slide 9
Fig. 2.4: Slide Show

	 7.	 Press Esc to exit the Slide Show.

Answers to textbook assessment

Assessment 2.1

Fill in the Blanks

	 1.	 What You See Is What You Get
	 2.	 blank document
	 3.	 Create	 4.	E diting

State Whether True or False

	 1.	 False	 2.	 True
	 3.	 True	 4.	 False

Answer the Following

	 1.	 To create and save a word document, the steps 
are:

	 (i)	O pen MS-Word 2007.
	 (ii)	 Click the Office Button. A menu appears.
	 (iii)	 Click New. The New Document dialog box 

appears.
	 (iv)	 Click Blank document.
	 (v)	 Click Create. A new blank document opens. 

Now, you can type the desired text in the 
document.

	 (vi)	 Click Save or Press Ctrl + S. The Save As dialog 
box appears if you are saving your document 
for the first time. 

	 (vii)	 Specify the correct folder in the Save In box.

	 (viii)	 Name your document by typing “Document 
Name” in the File Name box.

	 (ix)	 Click Save.
	 2.	 Formatting includes tasks such as changing the 

font, aligning and indenting text, changing line 
and paragraph spacing and inserting elements 
such as bullets, numbers, tables and pictures 
etc., in a document.

		  The Home tab is very useful in formatting a word 
document. Some of the formatting commands of 
MS-Word are explained below:

		  First of all select the text to be formatted either 
by using the keyboard by pressing shift key with 
arrow keys or using the mouse.

		  Bold: Click the  button or press (Ctrl + B) to 
make the selected text bold.

		  Italic: Click the  button or press (Ctrl + I) to 
italicize the selected text bold.

		  Underline: Click the  button or press  
(Ctrl + U) to underline the selected text.

		  Font Face: Press (Ctrl + Shift + F) to change the 
font face.

		  Font Size: Press (Ctrl + Shift + P) to change the 
font size.
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		  Align Text Left: Click the  button or press 
Ctrl + L to align text to the left.

		  Center Text: Click the  button or press 
Ctrl + E to center text.

		  Align Text Right: Click the  button or press 
Ctrl + R to align text right.

		  Justify: Click the  button or press  
Ctrl + J to align text to both the left and right 
margins, adding extra space between words as 
necessary.

		  Similarly on the Home tab, the Clipboard, Styles 
and Editing groups as well as the other buttons 
on the Font group and Paragraph group can be 
used for formatting a document.

		  The Insert tab can be used for inserting Tables, 
Pictures, applying Header and Footer in a 
document.

	 3.	 Spell checking in MS-Word:
		  We can use MS-Word’s spelling checker to 

find and correct the misspelled words and find 
duplicate words (such as and). The spelling 
checker compares words in the document to be 
spell checked with the words in its dictionary. If 
a match is found, the word is passed over. If no 
match is found for the word, the spelling checker 
stops, selects the word, and offers replacements. 
It can help in creating a well-written document 
but do not replace the need for proofreading.

		  To spell check in MS-Word 2007, perform the 
following steps:

	 (i)	O pen the document to be spell checked in 
MS-Word.

	 (ii)	 Place the cursor at the beginning of the text in 
the document.

	 (iii)	 Click Review tab.
	 (iv)	 Click the Spelling & Grammar button in Proofing 

panel or press F7.
	 (v)	 Ignore or change as per need.
	 (vi)	 Click OK.
	 (vii)	 Save and Close the document.
	 4.	 Inserting a table in MS-Word 2007 has changed 

slightly from previous versions of Word; 
however it is very easy with the new Ribbon 
user interface.

		  To insert a table in MS-Word 2007, perform the 
following steps:

	 (i)	O pen the document in which the table is to 
be inserted.

	 (ii)	 Click Insert tab.
	 (iii)	 Click Table button.
	 (iv)	 Drag in grid to select the desired number of 

columns and rows.
	 (v)	 Click OK.
	 (vi)	 Now fill the table as per your requirement.
	 (vii)	 Save and Close the document

Suggested Activities

	 Refer to sub-unit 2.1 of the Student Textbook for 
doing the activities.

Answers to Review Questions

Fill in the Blanks
	 1.	 presentation	 2.	 conferencing
	 3.	 Formatting	 4.	 sound

State Whether True or False
	 1.	 False	 2.	 True	 3.	 False	 4.	 True

Multiple Choice Questions
	 1.	 (d)	 2.	 (b)	 3.	 (c)	 4.	 (d)

Match the Following
	 1.	 (b)	 2.	 (a)	 3.	 (d)	 4.	 (c)

Answer the Following

	 1.	 Creating a Presentation: To create a presentation in 
PowerPoint 2007 you can either use a predefined 
template or create it from scratch. Creating from 
scratch is useful if you are not sure how you 
want your presentation to look. 

		  To create a presentation in PowerPoint 2007, 
perform the following:

		O  pen PowerPoint, a blank presentation is 
immediately created.

Or
	 (i)	 Click the Office Button. A menu appears.
	 (ii)	 Click New.
	 (iii)	 In the Blank and recent under category select 

Blank Presentation.
	 (iv)	 Click Create.
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		  The new presentation will default to the name 
of Presentation1, Presentation2, Presentation3 
etc. (the number increments each time you create 
one). 

		  To rename it click the Office Button. Click Save, 
and type in the desired name into the File 
Name box. Click Save or Press (Ctrl + S) on the 
keyboard.

		  Now, you are ready to start adding to your 
presentation.

	 2.	 Preparing and presenting a slide show:
		  For preparing a presentation keep in mind the 

following basic guidelines:
	 (i)	 Determine the main purpose of the 

presentation.
	 (ii)	 Determine the output.
	 (iii)	 Show one idea per slide.
	 (iv)	 Maintain a consistent design.
	 (v)	 Keep slides easy to read and uncluttered.
	 (vi)	 Determine printing needs.
		  Let us assume that you have already created a 

presentation. To present a slide show, perform 
the following steps:

	 (i)	 Click the Open Button on the Quick Access 
Toolbar. If the Open button does not display 
on the Quick Access Toolbar, click the 
Customize Quick Access Toolbar button that 
displays at the right side of the toolbar and 
then click Open at the drop-down list.

	 (ii)	 At Open dialog box, double-click on the 
desired presentation.

	 (iii)	 Click Slide Show tab.
	 (iv)	 Click From Beginning button or From Current 

Slide button.
	 (v)	 Run the presentation by clicking the left mouse 

button at each slide. At the black screen, click 
the left mouse button again.

	 (vi)	 Press Esc to exit the slide show.
	 3.	 Creating a presentation using design  techniques:
		  To create a presentation using design techniques, 

perform the following steps:
	 (i)	O pen PowerPoint.
	 (ii)	 At the PowerPoint window, click the Design 

tab.

	 (iii)	 Click the More button located at the right side 
of the Themes icons.

	 (iv)	 Click desired themes at drop-down gallery.
	 (v)	 For adding slide(s), click Home tab and then 

click New Slide button.
	 (vi)	 Save the presentation using the Save button 

on Quick Access toolbar.
	 4.	 Steps to change the layout of a slide:
		  To change the layout of a slide, perform the 

following steps:
	 (i)	O pen PowerPoint.
	 (ii)	 Make the desired slide active.
	 (iii)	 Click Home tab.
	 (iv)	 Click Layout button.
	 (v)	 Click desired layout at drop-down list.
	 (vi)	 Click Save.

Suggested Activities

	 Refer to sub-unit 2.2 of the Student Textbook for 
doing the activities.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject experts 
can be called for seminars to enrich the teaching level 
and in turn help the students in learning Application 
Software.

Additional Questions

	 1.	 What is the difference between Save and Save As 
commands in MS-Word?

	 2.	 How will you apply bullets and numbers to 
display ordered or unordered list in MS-Word?

	 3.	 How will you insert and delete a page break and 
page number in a document?

	 4.	 What are the main uses of presentation 
software?

	 5.	 What kind of help is available with a presentation 
software?

	 6.	 How will you create a slide show using animation 
and sound?
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INFORMATION AND 
COMPUTER SECURITY

(3 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l understand the responsible behaviour in the computer laboratory;

 l recognize the nature of computer virus and measures to protect.

suggested lesson plan

Sub-unit Number of 
Periods

3.1 Information and Computer 
Security

3

structure of the unit

3.1 Information and Computer Security

In this sub-unit, we will learn about basic concepts 
of Information and Computer Security. The topics 
to be learnt are:
 l Responsible behaviour in the computer lab
 l School ICT policy
 l Nature of computer viruses
  Measures to protect

review of the unit

	 l	Security of information and related computer 
systems is a big concern for the computer users.

	 l	Computer laboratory contains delicate and 
expensive equipment.

	 l	In computer lab; students must behave in a 
calm manner and not damage any machines 
or furniture; they must not touch any electrical 
connections for any reason.
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	 l	School ICT policy means rules prepared by the 
school and students must live with it.

	 l	Computer viruses are software programs which 
are proving to be main cause of crashing computer 
system. The best way to protect computer viruses 
is installing antivirus software.

role of the students

In this unit, the students are supposed to learn the 
basic concepts of Information and Computer Security. 
The activity-based method should be followed to 
understand the subject matter which is the best way 
of better understanding of the subject matter.
 Information and computer security plays a vital 
role in most of the organizations. Students are the one 
of the groups most targetted by identity thieves and 
computer hackers. Students work in many different 
computing environments and are often among the least 
protected against intrusions. They also frequently lack 
the knowledge that would help keep them safe. So, the 
students must know that Information and Computer 
Security is an important issue to protect themselves, 
even after completion of their education.
 note: Computer and information systems managers 
oversee a variety of workers, including systems 
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analysts, support specialists, and software engineers. 
They are aware of the latest ICT developments to 
ensure that the organization remains competitive. 

They may advance to progressively higher leadership 
positions in an ICT department or non-technical areas 
such as marketing, human resources and sales, etc.

ADDITIONAL CLASS ACTIVITy FOR GIFTED STUDENTS OR SLOW LEARNERS

ACTIVITY 3.1: Computer Viruses and Protection

Students will form groups in their class to discuss about computer viruses and protection.

Computer Virus

A computer virus is a “deviant” program, stored on a computer floppy drive, hard drive, or CD, that can 
cause unexpected and often undesirable effects, such as destroying or corrupting data. For example, boot-
sector virus, file virus, multipartite virus, macro virus, and logic bomb, etc.

Ways of Virus Passing
Viruses are passed in the following two ways:

	 1.	 By floppy disk: The first way is via an infected floppy disk, perhaps obtained from a friend or a repair 
person.

	 2.	 By the Internet or some other network: The second way is via a network such as, download (make 
copies of file) information from the Internet and other computer networks, or open files attached to  
e-mail. 

		  Figure 3.1 shows the working of viruses (Courtesy: www.contemposervices.com).

 
Fig. 3.1: Working of Computer Viruses

Protection 
For every individual computer user, the primary motive is PC protection. In other words, they must protect 
their computers from viruses.  A virus can expose the information or stop your computer from working. 
To help avoid computer viruses, it is essential that you keep your computer current with the latest updates, 
antivirus tools (antivirus software is a utility program that scans hard disks, floppy disks, and memory to detect 
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viruses), stay informed about recent threats, and follow a few basic rules when you surf the Internet, download 
files, and open attachments.
	 Once a virus is on your computer, its type or the method used to get there is not as important as removing 
it and preventing further infection. One important thing you can easily do is back up your files regularly (make 
sure they are not infected). 
	 A good antivirus software comes with features like a built-in firewall and usually offers an access to online 
data backup. Firewalls are systems which help protect computers and computer networks from attack and 
subsequent intrusion. Visit the website www.mobrien.com for more information on Firewalls.
	 Figure 3.2 shows Kaspersky Antivirus website.

Fig. 3.2: Kaspersky Antivirus website (www.kaspersky.com)

	 Some of the best antivirus software are:
	 1.	 Kaspersky				    2.	 Avast
	 3.	 Norton 2011			   4.	 Microsoft Security Essentials
	 5.	 AVG				    6.	 Comodo
	 7.	 McAfee				    8.	 Trend Micro
	 9.	 Avira AntiVir		  10.	 BitDefender

	 So, it is totally up to you to select which one is the best antivirus for you as per your requirement and your 
system configurations. Visit the following websites for more information on antivirus software:

	 l	 en.softonic.com
	 l	 www.freedownloadscenter.com
	 l	 www.brothersoft.com
	 l	 www.microsoft.com
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Answers to review Questions

Fill in the Blanks

	 1.	 delicate, expensive	 2.	 electrical
	 3.	 computer virus	 4.	 antivirus

State Whether True or False

	 1.	 False	 2.	 True
	 3.	 False	 4.	 False

Multiple Choice Questions

	 1.	 (d)	 2.	 (a)
	 3.	 (b)	 4.	 (c)

Match the Following

	 1.	 (b)	 2.	 (c)
	 3.	 (d)	 4.	 (a)

Answer the Following

	 1.	 A computer laboratory contains delicate and 
expensive equipment. Students must behave in 
a calm manner and not damage any machines 
or furniture; they must not touch any electrical 
connections for any reason. The guidelines to be 
followed in the computer lab are:

	 (i)	 Students are not allowed in the computer 
lab unless directly supervised by a computer 
teacher or any other staff member.

	 (ii)	 Never share your password, even with your 
best friend.

	 (iii)	 No gum, snacks or drinks are allowed in the 
computer lab, electronic equipment does not 
like to get wet or sticky.

	 (iv)	 Listen to directions given by your computer 
teacher.

	 (v)	 Review your notes, on-line materials and of 
course the HELP option in all programs.

	 (vi)	 Use the Internet only as instructed. Do not 
click on links that seem suspicious or give 
offers of anything “free”.

	 (vii)	 Do not use the mouse or keyboard as a toy, 
that is, do not randomly click on the mouse 
or hit the keys on the keyboard without a 
purpose.

	 (viii)	 Do not change computer preference settings 
or endeavour to “hack” into unauthorized 
areas.

	 (ix)	 Always use print preview before you print. 
	 (x)	 Take permission from your computer teacher 

before printing.
	 (xi)	 Before leaving from the computer lab you 

should follow these procedures: 
	 (a)	E xit any programs you are using.  The 

login screen should be showing on the 
desktop. Return supplies (if any).

	 (b)	 Straighten your work area and retrieve 
your books from the book shelf.

	 (c)	 Log Off/Turn Off your computer and push 
in your chair.

	 2.	 Safe online behaviour: Netiquette, or “network 
etiquette” means safe or appropriate online 
behaviour.

		  In general, safe online behaviour has two basic 
rules:

	 (a)	 do not waste people’s time, and
	 (b)	 do not say anything to a person online that 

you would not say on his or her face.
		  Some other specific rules of safe online behaviour 

are given below:
	 (i)	 Consult FAQs (Frequently Asked Questions) 

which have expected norms of online 
behaviour for particular groups.

	 (ii)	 Avoid flaming, that is, writing an online 
message that uses derogatory, obscene, 
or inappropriate language. You can use 
emoticons—Keyboard-produced pictorial 
representations of expressions for smooth 
online communications.

	 (iii)	 Do not Shout, that is, avoid use of all 
capital letters except when they are required 
for emphasis of a word or two (as when you 
cannot use italics in your e-messages).

	 (iv)	 Be careful with jokes as some people take 
these as insults or criticism.

	 (v)	 Avoid sloppiness, but avoid criticizing 
others’ sloppiness, that is, avoid spelling and 
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grammatical errors. However, do not criticize 
these same errors in others’ messages. (As they 
may not have English as a native language.) 
Use the spell-checking capability of the e-mail 
software.

	 (vi)	 Do not send huge file attachments, unless 
requested as it may take a long time to 
download a massive file. Also, the receipent 
must have the appropriate software to open 
your attachment.

	 (vii)	 When replying, quote only the relevant 
portion.

	 (viii)	 Do not “over forward,” that is, check the e-mail 
contents before using automatic forwarding.

	 3.	 School ICT Policy: The school ICT policy means the 
rules prepared by the school to use ICT. When 
deciding on the school’s aims for ICT, internal, 
local and national factors should be considered.

		  The school’s overall aim for ICT is to enrich 
learning for all students. The school management 
must ensure that ICT Co-ordinator and computer 
teachers develop confidence and competence to 
use ICT as a tool aiding effective teaching across 
the curriculum.

		  The school ICT policy must identify the important 
issues and guide the students to live with it. 
Some of these include:

	 (i)	 A statement defining ICT capability.
	 (ii)	 The aims for ICT in the school.
	 (iii)	 Guidance on record-keeping, assessment.
	 (iv)	 Guidance on health and safety.
	 (v)	 Specific rules for the use of Internet and 

e-mail.
	 (vi)	 Statement of the school’s position on 

copyright, data protection.
	 (vii)	 Information regarding maintenance/repair/

viruses.
	 (viii)	 Date for review.
	 4.	 Computer Virus: A computer virus is a malicious 

program that is designed to corrupt or delete the 
information stored in the computer. Computer 
viruses are spread through transportable 
secondary storage devices and networks.

	 	 Measures to Protect Computer Virus: The best way 
to protect computer viruses is installing antivirus 

software. Antivirus software consists of computer 
programs that attempt to identify, thwart and 
eliminate computer viruses and other malicious 
software (malware).

		  A good antivirus software comes with features 
like a built-in firewall and usually offers an access 
to online data backup. This antivirus software has 
the option to deactivate the malicious viruses. 

		  Firewalls are systems which help protect 
computers and computer networks from attack 
and subsequent intrusion.

		  The computer users should follow these safety 
rules to protect against viruses:

	 (i)	 Do not open unsolicited e-mails.  
	 (ii)	 Never download an attachment of an e-mail 

without scanning it for viruses first. 
	 (iii)	 Make sure you also use a firewall. 
	 (iv)	 Do not download free software or music. 
	 (v)	 Do not use free antivirus software. 
	 (vi)	 Search on Internet for antivirus reviews and 

analyse yourself for best antivirus software.

Suggested Activities

	 Refer to sub-unit 3.1 of the Student Textbook for 
doing the activities.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips or subject experts 
can be called for seminars to enrich the teaching level 
and in turn help the students in learning Information 
and Computer Security.

Additional Questions

	 1.	 What do you mean by security of a computer 
system?

	 2.	 What is the importance of responsible behaviour 
in the Computer Laboratory?

	 3.	 What does online mean?
	 4.	 Discuss the importance of school ICT policy.
	 5.	 How does a virus affect a computer system?
	 6.	 How does firewall work?
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APPLICATION 
SOFTWARE

(15 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l  recognize the uses of spreadsheets; 

 l understand the screen elements in the spreadsheet window; 

 l recognize how to create and use simple spreadsheet using text and numbers; 

 l understand how to format worksheets; 

 l recognize to use built in functions and create custom formula.

suggested lesson plan

Sub-unit Number of 
Periods

4.1 Spreadsheets 15

structure of the unit

4.1 Spreadsheets

In this sub-unit, we will learn about basics of 
spreadsheets. The topics to be learnt are:
 l Introduction
 l Starting Spreadsheets
 l Screen elements of Spreadsheets
 l Create and Use a Simple Spreadsheet
 l entering and editing Text
 l Saving the Worksheet
 l Using the Four Mathematical operators on Data 

to Create Custom Formula
 l Addition
 l Sum (dragging)

unit 4   

 l entering a Formula into a Cell
 l Copying by Using the Fill Handle

review of the unit

	 l	A spreadsheet is a document which helps 
you organize data in rows and columns that             
intersect to form cells.

	 l	In a spreadsheet each cell can contain words, a 
number, or a formula.

	 l	Some examples of spreadsheets are Microsoft 
excel, Corel Quattro Pro, openoffice Calc, 
Google Spreadsheets and Lotus–123 etc.

	 l	MS-excel has screen similarities with MS-Word 
and other MS products; main differences in a 
spreadsheet are

 (i) the formula bar which is used for operations 
on cells such as calculations

 (ii) the working area.
	 l	A function is a built-in formula that performs 

calculations on a range of values. Some examples 
of functions are SUM, AVeRAGe, CoUNT, 
MAX, MIN.
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ROLE OF THE STUDENTS

In this unit, the students are supposed to learn the 
basic concepts of Spreadsheets. The activity based 
method should be followed to understand the subject 
matter which is the best way of better understanding 
of the subject matter.
	 Perhaps the most used software in accounting 
applications is an electronic spreadsheet, such as 
Microsoft Excel. Spreadsheets are extremely powerful 

in that they contain large amounts of data that can 
be summarized or displayed in many user-friendly 
formats. Creating a well-designed spreadsheet is often 
as much an art as science. The students generally have 
different levels of understanding for various topics. By 
the end of this unit, every student is expected to create 
user-friendly spreadsheets. Students having more 
advanced knowledge are expected to learn new skills 
as well as  help their less-experienced classmates.

ADDITIONAL CLASS ACTIVITy FOR GIFTED STUDENTS OR SLOW LEARNERS

ACTIVITY 4.1: Navigating a Worksheet

In groups, the students will explain and demonstrate the navigation in a worksheet.
Scrolling Techniques

In large worksheets, you will need to scroll to the right or scroll down to locate cells with which you need to 
work. The horizontal and vertical scroll bars are used to scroll with the mouse. Scrolling by using the scroll 
bars does not move the position of the active cell. You can also scroll using the arrow keys or with keyboard 
commands. Scrolling by using the keyboard moves the active cell.

Fig. 4.1: Scrolling in a large worksheet

Keyboard Movement Commands
Table 4.1 shows some keyboard scrolling techniques:

Table 4.1: Keyboard Movement Commands
Press To move to

Arrows keys one cell up, down, left, or right

Ctrl + Home A1

Ctrl + End last cell in worksheet

Home beginning of row

Page Down down one screen

Page Up up one screen

Alt + Page Down one screen to the right

Alt + Page Up one screen to the left
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Go to Specific Cell

To go to specific cell in a worksheet, perform the following steps:
	 (i)	 Start Excel and open a workbook.

	 (ii)	 Click the Home tab.

	 (iii)	 Click the Find & Select button in the Editing group (see Fig. 4.2)

	 (iv)	 Click Go To at the drop-down list.

	 (v)	 The Go To dialog box appears (see Fig. 4.3).

		  	

		  Fig. 4.2: Clicking Find and Replace	 Fig. 4.3: Go To dialog box

	 (vi)	 Type cell address in the Reference text box.
	 (vii)	 Click OK or press Enter key.
	 (viii)	 Click the Office Button. A menu will appear.
	 (ix)	  Click Close.

Answers to review Questions

Fill in the Blanks

	 1.	 MS-Excel 2007	 2.	 workbook
	 3.	 fill handle	 4.	 built-in functions

State Whether True or False

	 1.	 True	 2.	 False	 3.	 True	 4.	 False

Multiple Choice Questions

	 1.	 (d)	 2.	 (c)	 3.	 (a)	 4.	 (b)

Match the Following

	 1.	 (c)	 2.	 (d)	 3.	 (b)	 4.	 (a)

Answer the Following
	 1.	 Spreadsheet: A spreadsheet is a document which 

helps you organize data in rows and columns 
that intersect to form cells.

		  Purpose of a spreadsheet: A spreadsheet package is a 
numeric data analysis tool, which not only allows 
us to quickly calculate and analyse numbers, but 
also lets us quickly explore a variety of possible 
outcomes. The spreadsheet allows users to create 
tables and financial schedules by entering data and 
formulae into rows and columns arranged as a grid 
on a display screen.

		  Examples: Some examples of spreadsheets are 
Microsoft Excel, Corel Quattro Pro, OpenOffice 
Calc, Google Spreadsheets, Lotus-123, etc.

	 2.	 Creating and saving worksheet in MS-Excel: Suppose 
you are having MS-Excel 2007 installed on your 
computer. 

		  To create and save a worksheet in Excel 2007, 
perform the following steps: 
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	 (i)	 Double-click on the MS-Excel 2007 icon on 
the desktop.

OR
		  Click Start → All Programs → Microsoft Office 

→ Microsoft Office Excel 2007
		  A workbook named Book1 will be created. 

A workbook can contain several worksheets. 
Now, you can enter the data as per your 
requirement.

	 (ii)	 Click Office Button.
	 (iii)	 Click Save As.
	 (iv)	 Type new workbook name.
	 (v)	 Click Save or press Enter key. Excel 

automatically adds the file extension .xlsx to 
the end of a workbook name.

	 3.	 Inserting rows or columns in Excel: We can insert 
rows or columns using options from the Insert 
button in the Home tab or from the context 
sensitive shortcut menu that displays on right-
clicking a selected area. Inserted rows are placed 
above the active cell or selected rows and existing 
rows are shifted down. Columns are inserted left 
of the active cell or selected columns and existing 
columns are shifted right.

		  To insert rows or columns in Excel 2007, perform 
the following steps:

	 (i)	O pen the worksheet.
	 (ii)	 Select required number of rows or columns.
	 (iii)	 Click the Home tab.
	 (iv)	 Click the Insert button arrow in the Cells 

group.
	 (v)	 Click Insert Sheet Rows or Insert Sheet 

Columns.
		  Deleting rows or columns in Excel: We can delete 

rows or columns using options from the Delete 
button in the Home tab or from the context 
sensitive shortcut menu that displays on right-
clicking a selected area. When rows or columns 
are deleted, data automatically is shifted up or 
left to fill space and references in formulas are 
updated.

		  To delete rows or columns in Excel 2007, perform 
the following steps:

	 (i)	O pen the worksheet.
	 (ii)	 Select rows or columns to be deleted.

	 (iii)	 Click the Home tab.
	 (iv)	 Click the Delete button arrow in the Cells 

group.
	 (v)	 Click Delete Sheet Rows or Delete Sheet 

Columns.
		  Inserting and deleting cells in Excel: We can insert 

new blank cells or delete a range of cells within 
the worksheet area. 

		  To insert cells in Excel 2007, perform the following 
steps:

	 (i)	O pen the worksheet.
	 (ii)	 Select the range of cells you need to add.
	 (iii)	 Click the Home tab.
	 (iv)	 Click the Insert button in the Cells group or 

click the Insert button arrow and then click 
Insert Cells at the drop-down list to open the 
Insert dialog box.

	 (v)	 Using the dialog box, choose to shift the 
existing cells right or down.

		  To delete cells in Excel 2007, perform the 
following steps:

	 (i)	O pen the worksheet.
	 (ii)	 Select the range of cells you need to delete.
	 (iii)	 Click the Home tab.
	 (iv)	 Click the  Delete button in the Cells Group or 

click the Delete button arrow and then click  
Delete Cells at the drop-down list to open the 
Delete dialog box.

	 (v)	 Using the dialog box, delete the selected range 
of cells to shift up the cells below the deleted 
range.

	 4.	 Built-in functions in Excel: A function is a built-in 
formula that performs calculations on a range of 
values. It allows you to perform mathematical, 
statistical and date-time functions. For example, 
Sum, Average, Count, Max, Min etc. 

		  The syntax of writing a function in Excel is: 
		  = <Function name>(<List of arguments>) 
		  SUM( ): Adds all the numbers in a range of cells. 

The syntax of SUM( ) function is:
		  SUM(number1, number2, ...)
		  Here, 
		  number1, number2, ...   are 1 to 255 arguments 

for which you want the total value or sum.
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		  For example,
		  = SUM(2,5) adds 2 and 5 (7)
		  = SUM(“5”,14,TRUE) adds 5, 14 and 1, because 

the text values are translated into numbers, and 
the logical value TRUE is translated into the 
number 1 (20)

		  = SUM(A2:E2) will find the sum (total) of 
numbers in the specified range.

		  AVERAGE( ): Returns the average (arithmetic 
mean) of the arguments. The syntax of 
AVERAGE( ) function is:

		  AVERAGE(number1, number2, ...)

ACTIVITY 4: Explain and demonstrate cell reference: Absolute and Relative

In small groups the students will explain and demonstrate absolute and relative cell references.

Cell Reference

A cell reference consists of the column letter and row number that intersect at the cell’s location (the column 
letter is always used first). It identifies a cell or a range of cells on a worksheet and tells Excel, about where 
to look for the values or data that you want to use in a formula.  With references, you can use data contained 
in different parts of a worksheet in one formula or use the value from one cell in several formulas.
	 We can refer to a cell or range of cells in formulae in three ways: relative reference, absolute reference and 
mixed reference (a mixture of relative and mixed reference).

Relative reference
In Excel and other spreadsheets, a relative cell reference identifies the location of a cell or group of cells. The 
cell references are used in formulas, functions, charts, and other Excel commands. By default, a spreadsheet 
cell reference is relative. This means that as a formula or function is copied and pasted to other cells, the cell 
references in the formula or function change to reflect the function’s new location, that is, Excel updates the 
cell references. For example,

	 1.	 Start Excel to start a new blank workbook

	 2.	 In cell D1, D2, enter 30, and 25 respectively.

	 3.	 In cell E1, enter = D1*2.

	 4.	 Press Enter.

		  Cell E1 now returns the value 60.

	 5.	 If E1 is not the active cell, click it once.

	 6.	 Press Ctrl + C, or click the Copy button on the Home tab.

	 7.	 Click cell E2.

	 8.	 Press Ctrl + V, or click the Paste button on the Home tab.

	 9.	 If you see a moving marquee around cell E1, press the Esc key.

		  Cell E2 should be the active cell, but if it is not, just click it once. Look at the Formula bar. The contents 
of cell E2 are = D2*2 (see Fig. 4.4) and not the = D1*2 that you copied.

		  Here,
		  number1, number2, ... are 1 to 255 numeric 

arguments for which you want the average.
		  For example, 
		  = AVERAGE(10,7,9,27,2) will find the average of 

the numbers given as arguments (11)
		  = AVERAGE(A2:E2) will find the average of 

numbers in the specified range.

Suggested Activities

	 Refer to sub-unit 4.1 of the Student Textbook for 
doing activities 1, 2 and 3.
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Fig. 4.4: Relative references adjust when a formula is copied

	 	 What has happened? Excel, in its wisdom, assumed that if a formula in cell E1 references the cell 
D1—one cell to the left—then the same formula put into cell E2 is supposed to reference cell D2—also 
one cell to the left.

Absolute reference
In Excel and other spreadsheets, an absolute cell reference identifies the location of a cell or group of cells. In 
an absolute cell reference, a dollar sign ($) precedes both the column letter and the row number. For example, 
= $A$1
	 An absolute cell reference is used when you want a cell reference to stay fixed on a specific cell. This means 
that as a formula or function is copied and pasted to other cells, the cell references in the formula or function 
do not change. For example, in the earlier example of relative reference, if in cell E1, you enter = $D$1*2 and 
repeat the copy/paste steps, Excel will  show the same result in cell E2 as shown in cell E1? (see Fig. 4.5).

Fig. 4.5: Absolute references do not change when a formula is copied

Use shortcut keys to toggle through the dollar-sign permutations. Specifically, highlight the cell reference 
that you want to change in the formula bar. Press the F4 function key to toggle through the different possible 
placements of $.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject experts 
can be called for seminars to enrich the teaching level 
and in turn help the students in learning Application 
Software.

Additional Questions

	 1.	 What can you do with an electronic spreadsheet 
that you cannot do with pencil and paper and a 
standard calculator?

	 2.	 What is editing? How editing is performed in 
Excel?

	 3.	 What is auto sum utility of Excel?
	 4.	 What is a fill handle? What are its uses?
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USING INTERNET
(10 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l understand the Internet as a global network;

 l recognize the meaning of some basic terms related to the Internet;

 l recognize the work with a search engine to search for items;

 l understand hotspots and hyperlinks;

 l comprehend the meaning of some common e-mail terms.

suggested lesson plan

Sub-units Number of 
Periods

5.1 Using Internet 5

5.2 Using e-mail 5

structure of the unit

5.1 Using Internet

In this sub-unit, we will learn about basics of Using 
Internet. The topics to be learnt are:
 l Definition of Internet
 l Uses and Services Available on the Internet
 l Terms
 l Types of Browsers Software
 l Screen elements of Internet explorer
 l Using Internet
 l Browsing Information
 l Saving Document
 l Saving Images

unit 5   

 l Printing Documents
 l Searching Information

5.2 Using E-mail

In this sub-unit, we will learn about basics of Using 
e-mail. The topics to be learnt are:
 l Creating an e-mail account
 l Composing and sending an e-mail
 l Receiving and replying to an e-mail
 l Facilities of an e-mail system
 l Distribution list
 l Attachments
  Sending
  Receiving
 l Auto Reply

review of the unit

	 l	Internet is the network that is available to users 
across the globe.

	 l	The major use of Internet is for searching the 
information stored in millions of computers of 
the Internet.



Unit 5 – Using Internet

	36	  n	 Information Communication Technology — Grade 9 Teacher Guide

	 l	A web browser, or simply browser, is software 
that enables users to locate and view web 
pages and to jump from one page to another. 
For example, Internet Explorer, Mozilla Firefox, 
Google Chrome etc.

	 l	Screen elements of Internet Explorer are: Menu 
bar, Address bar, Standard toolbar, Workspace, 
Content window, Status bar etc.

	 l	Examples of search engines are AltaVista, Lycos, 
Google and Yahoo.

	 l	E-mail is the exchange of messages stored on 
computers, through a communication channel.

	 l	To send and receive e-mail, you need to create 
an account with an e-mail service provider.

	 l	Composing of an e-mail message is done very 
much like a paper letter.

	 l	All e-mail systems have the ability to send, 
receive and discard mail.

	 l	Auto Reply feature is useful when you are on 
holidays and want to inform people that you 
would not be checking your e-mail for a few 
days.

ROLE OF THE STUDENTS

In this unit, the students are supposed to learn the 
basic concepts of Internet. The activity based method 

should be followed to understand the subject matter 
which is the best way of better understanding of the 
subject matter.
	 The Internet is an extremely useful resource for 
students.  There is a lot of information that can save 
a student from a trip to the library. There are many 
reputed websites with information about all sorts of 
subjects. Students must be very careful when searching 
information from the Internet, however, especially for 
work in a school assignment. 
	 The Internet can be a resource in many other ways. 
Many ICT and other subject teachers will actually use 
the Internet for their classes. They may post information 
or assignments for their students on the Internet. 
Some of them will post marks/grades on the Internet 
or communicate with their students. Some important 
topics are taught by the ICT teachers on the Internet. 
In this way, the Internet can also be a good resource 
for students.
	 Using Internet, the students will be able to 
communicate effectively, that is, they will have a 
range of skills to express themselves through new 
environments (e-mail, websites, etc.).

ADDITIONAL CLASS ACTIVITy FOR GIFTED STUDENTS OR SLOW LEARNERS

ACTIVITY 5.1: Screen Elements of Mozilla Firefox Browser 

Students in their class will explain and demonstrate the screen elements of Mozilla Firefox web 
browser.

Browser
A web browser, or simply browser, is software that enables users to locate and view web pages and to jump 
from one page to another. For example, Mozilla Firefox. 

Screen Elements of Mozilla Firefox
Most browsers have a similar look and feel. The Mozilla Firefox web browser screen has five basic 
elements:

	 (i)	 Menu bar	 (ii)	 Toolbar
	 (iii)	 URL bar	 (iv)	 Workspace
	 (v)	 Status bar

	 To execute menu bar and toolbar commands, we use the mouse to move the pointer over the word, 
known as menu selection, and click the left button of the mouse. This will result in a pull-down menu of other 
commands for other options (see Fig. 5.1).
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Fig. 5.1: Mozilla Firefox browser screen elements

	 Visit the website www.mozilla.com for Mozilla Firefox features.

	 	Bookmarks or favorites
One great helper for the users is the bookmark or favorite system, which lets them store the URLs of web pages 
they frequently visit, so that they do not have to remember and retype their favorite addresses. For this, click 
on the Bookmarks or Favorites feature, which displays the URL on the screen, and then click on Done or Add, 
which automatically stores the address. Later on locate the site name on the Bookmarks menu, click on it, and 
the site will reappear. To delete the bookmark, use the right mouse button and select the Delete command. 

Answers to textbook assessment

Assessment 5.1

Fill in the Blanks

	 1.	 Internet	 2.	 website (site)
	 3.	 browser	 4.	 search

State Whether True or False

	 1.	 False	 2.	 True	 3.	 False	 4.	 True

Answer the Following

	 1.	 Internet: Internet is the network that is available 
to users across the globe. It is called “the mother 
of all networks”.

		  Who governs the Internet?
		  No one governs the Internet. The Internet is 

coordinated by many volunteer organisations 
and no single organisation is having the complete 
control over it.

	 2.	 Using Internet and WWW: The Internet and 
WWW are not the same thing. The Internet is 
a massive network of networks, connecting 
millions of computers via protocols, hardware, 
and communications channels. The WWW is a 
means of accessing information available on the 
Internet using software called browser.

		  An ISP (Internet Service Provider) helps the 
Internet users to connect to the Internet. The ISP 
functions as an interface between the user and 
the rest of the Internet.  The Internet contains 
information in the form of web pages grouped 
into websites. The major use of the Internet is 
for searching the information stored in millions 
of computers around the world. It can keep 
the user updated about everything happening 
in the world. The user can search for the 
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information, take part in online text, audio or 
video conversation or can share the information 
with the other users of the Internet.

		  WWW or World Wide Web has changed the 
picture of the Internet after its creation. Earlier, 
Internet was used to share textual information 
only. There were no graphics, no animations and 
no links as you see in today’s Internet. All credit 
goes to WWW which provides easy and effective 
way of storing and accessing information on the 
Internet. The e-mail is used to send and receive 
messages instantly.

	 3.	 Website: A computer with a domain name is 
called a website (site). The top-level domains are 
.com, .edu, .org, and .net. For example, www.
google.com, www.microsoft.com. 

		  Webpage: A web page is a document on the World 
Wide Web that can include text, pictures, sound 
and video. The first page you see on a website is 
like the title page of a book. This is the home page, 
or welcome page, which identifies the website 
and contains links to other pages at the site.

		  Browser: A web browser, or simply browser, is 
software that enables users to locate and view 
web pages and to jump from one page to another. 
It is what you use to get around the web. A web 

browser makes it easy to navigate (or “surf”) 
the web and to download items. For example, 
Internet Explorer.

	 4.	 Types of Browsers: Browser is software that 
enables users to locate and view web pages and 
to jump from one page to another. More than 
one web browser can also be installed on a single 
computer. Some of the best-known browsers 
are:

	 (i)	 Internet Explorer: Internet Explorer is the most 
widely-used web browser by people around the 
world. It is commonly known as IE. The latest 
version is Internet Explorer 8.

	 (ii)	 Mozilla Firefox: Mozilla Firefox browser is coming 
up very fast i.e., its users are increasing every 
day. It is the second-most famous browser after 
Internet Explorer.

	 (iii)	 Google Chrome: This web browser was developed 
by Google. Google Chrome is providing a tough 
fight to other web browsers and is very popular 
among users.

Suggested Activities

	 Refer to sub-unit 5.1 of the Student Textbook for 
doing Activity 1.

ACTIVITY 2:	 Explain that Each Website has a Unique Address; a Website Holds Information; 
Creation of Websites Briefly; there may be a few or many Pages on the 
Website 

In groups the students will explain that each website has a unique address; a website holds information; creation 
of websites briefly; there may be a few or many pages on the website.

Website

A computer with a domain name is called a website (site). Figure 5.2 shows a website.

Fig. 5.2: A website
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URL (Uniform Resource Locator)
The URL is a string of characters that points to a specific piece of information anywhere on the web. In other 
words, the URL is the website’s unique address. For example, 

http://www.selamta.net/national_parks.htm
is a URL for a website offered by Selamta for Ethiopian National Parks. A URL is not the same thing as an 
e-mail address.
	 A website holds information. For example, the website shown in Fig. 5.2 shows information about Ethiopian 
National Parks. Websites provide multimedia content to users.

Creation of Websites
The World Wide Web (WWW) is a great way to give information about yourself and your work to others. 
To do so, you need to have a web page and put it online.  Professional web page designers can produce a 
website for you or you can do it yourself using a menu-driven program included with your web browser or 
a web page design software package. 
	 Fortunately, providers offer some free, easy to use web authoring tools for creating simple websites. They 
help you create web pages using icons and menus to automate the process; you do not need to know HTML 
(Hypertext Markup Language) for it. These automated tools let you select a prepared, template web page 
design, type a few words, add a picture or two—and your work is done. To save the pages and make them 
accessible on the Internet, the provider grants you a certain amount of space on its web servers.
	 Some web design software packages are: 

	 (i)	 Intuit Website Creator 2010	 (iv)	 Web Studio 5.0
	 (ii)	 Web Easy Professional 8	 (v)	 Adobe Dreamweaver CS5
	 (iii)	 Microsoft FrontPage

	 The www.brothersoft.com website offers many web design software (see Fig. 5.3).

Fig. 5.3: Website www.brothersoft.com offers  web design software

	 A website may consist of a single page—the home page. Large websites have a number of pages 
(in hundreds). Remember that the contents of home pages often change. Or they may disappear, and so the 
connecting links to them in other web pages become links to nowhere.
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ACTIVITY 3:	 Explain and Demonstrate some Hyperlinks, and Returning Back to the Original 
Web Page 

In groups, the students will explain and demonstrate some hyperlinks, and returning back to the original web 
page.

Hyperlink
A hyperlink (link) is a word, group of words, or image that you can click on to jump to a new web page or a 
new section within the current web page.
Using hyperlinks
Connect to the Internet using a browser. Here, we have used Mozilla Firefox. Using Google search engine 
(www.google.com) type “ethiopian food” in the Search box and press Enter key. The websites having information 
on the search topic are displayed in the Search results tab (see Fig. 5.4).

Fig. 5.4: Hyperlinks 

	 When you move the cursor over a hyperlink in a Web page, the arrow will turn into a little hand. 
Clicking the left mouse button on underlined or color term transfers you to another web page  
(see Fig. 5.5).

Fig. 5.5: Moving to another web page using hyperlink

Hyperlink
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	 To return back to the original web page click the Navigation button  (see Fig. 5.6)

Fig. 5.6: Returning back to the original web page

	 So, you can use a hyperlink to connect to another page within the website or to another site on the Internet. 
Use the browser Toolbar for navigational aids.

	 Close the web browser when your work is over.   

Answers to Review Questions

Fill in the Blanks

	 1.	 Internet	 2.	 online
	 3.	 attachments	 4.	 distribution list

State Whether True or False

	 1.	 False	 2.	 False	 3.	 True	 4.	 False

Multiple Choice Questions
	 1.	 (a)	 2.	 (b)	 3.	 (d)	 4.	 (a)

Match the Following
	 1.	 (b)	 2.	 (a)	 3.	 (d)	 4.	 (c)

Answer the Following

	 1.	 E-mail: E-mail or electronic mail is the exchange 
of messages stored on computers, through a 
communication channel.

		  Steps to create an e-mail account: In today’s world, 
an e-mail account is essential for communication. 
It allows users to communicate with others (e.g., 
family, friends, and teachers), send resumes for 
employment online, and create memberships 
and accounts with different websites. There are 
many e-mail service providers to choose from. 
The most popular e-mail providers are Yahoo!, 
Gmail and Hotmail. One must use common 
sense while creating e-mail accounts.

		  To create an e-mail account with Yahoo! Mail, 
perform the following steps:

	 (i)	 Connect to the Internet.
	 (ii)	 Go to mail.yahoo.com.
	 (iii)	 Select “Sign Up” under the login fields.
	 (iv)	 Create the Yahoo! mail account. Enter the 

name, gender, birth date, country and zip code. 
Enter the Yahoo! ID that will be used as the 
email address (e.g., shibru2011@yahoo com). 
The “Check” button can also be selected to 
make sure that name is still available. If not 
available, chose another name or pick from 
the suggestions Yahoo! provides. Enter the 
password and select a security question in 
case you forget the password. Lastly, enter 
the captcha code.

	 (v)	 Select the “Create Account” button and the 
new Yahoo! e-mail is now available for use.

	 2.	 Steps to compose and send an e-mail: Perform the 
following steps to compose and send an e-mail: 

	 (i)	 Connect to the Internet.
	 (ii)	 Go to the e-mail program.
	 (iii)	 Click the Compose Mail, New Mail, Write 

Message or similar button, depending on the 
application you are using to create a new 
e-mail message.

	 (iv)	E nter the address of the recipient in the To 
field.

	 (v)	 Type a subject in the Subject field.
	 (vi)	 In the message area, add a message to the 

body of the e-mail. 
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	 (vii)	 Click the Send button.
	 (viii)	 Close the e-mail program.
	 3.	 Steps to receive and open an e-mail: Perform the 

following steps to receive and open an e-mail: 
	 (i)	 Connect to the Internet.
	 (ii)	 Go to the e-mail program.
	 (iii)	 In Inbox, look for the received mail(s). 
	 (iv)	 Click on the desired mail in the list to open 

and read the e-mail message.
	 (v)	 Close the e-mail program.
	 4.	 Facilities provided in the e-mail system: All e-mail 

systems have the ability to send, receive and 
discard mail. Most systems have facilities for 
storing mail which is to be kept rather than 
discarded. It is important for you to discard 
mail which does not need to be kept, as it uses 
storage space on disks. Mailboxes can soon 
accumulate a large number of mail messages 
making it difficult to read and process new mail, 
in addition to wasting disk space.

		  There is almost always a connection between the 
e-mail system and the computer’s standard file 
system which allows mail to be read from files or 
written to files. This enables greater flexibility in 
how the mail system is used. For example, a mail 
message may be prepared in a normal file using 
a familiar text editor and then sent by the e-mail 
system. Sections of other files may be included in 
the mail message as well.

		  Most systems have a reply facility, although some 
of these do not always work as expected. A great 
care should be taken when using this facility in 
e-mail, as replies do not always go back to the 
sender.

Suggested Activities

	 Refer to sub-unit 5.2 of the Student Textbook for 
doing the activities.

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL

The ICT teachers can use Internet, charts, worksheets, 
models, go for educational field trips and subject 
experts can be called for seminars to enrich the teaching 
level and in turn help the students in learning “Using 
Internet”.

Additional Questions

	 1.	 Write any two uses of Internet.

	 2.	 Why do we use a web browser? 

	 3.	 What are search engines? Identify types of search 
engines.

	 4.	 Give some tips for searching the Internet.

	 5.	 Write main advantages of using e-mail.
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CONTROL AND 
LEARNING WITH LOGO

(7 PERIODS)

   UNIT OUTCOME
 Students will be able to:

 l  understand the LOGO language; 

 l recognize to produce a variety of diagrams using the LOGO language.

suggested lesson plan

Sub-unit Number of 
Periods

6.1 Control and Learning with 
LoGo

7

structure of the unit

6.1 Control and Learning with LoGo

In this sub-unit, we will learn about Control and 
learning with LoGo. The topics to be learnt are:
 l Using Primitives
 l Writing Procedures Using Random

review of the unit

	 l	LoGo stands for Logic oriented, Graphics 
oriented.

	 l	MSW LoGo screen is divided in two parts—
Graphics window and Listener window.

	 l	CS primitive clears the graphics screen.
	 l	We can write a procedure in two ways using the 

“Input Box” or using the “editor window”.

unit 6   

	 l	Procedures are small programs that can be called 
on again and again through one word without 
typing them all out.

	 l	The file saved in LoGo will have an extension 
LGo.

	 l	BYe primitive closes the LoGo.

role of the students

In this unit, the students are supposed to learn the 
basic concepts of “Control and learning with LoGo”. 
The activity based method should be followed to 
understand the subject matter which is the best way 
of better understanding of the subject matter.
 LoGo is considered the first step of learning 
programming language by the students. MSW LoGo 
is the perfect introduction to computer programming. 
It is easy to learn, easy to use, easy to read, but also 
powerful and able to cope with complex problems. It 
can be used to teach most computer science concepts. 
Many LoGo commands have mnemonic short forms; 
for example, FoRWARD and RIGHT are coded FD and 
RT respectively. So, it is the first choice of the students 
to learn the programming concepts.
 LoGo’s best-known feature is the turtle, which 
is an on-screen cursor (derived originally from 
a robot of the same name), which can be given 
movement and drawing instructions, and is used 
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to programmatically produce line graphics. It is 
traditionally and most often represented pictorially 
either as a triangle or a turtle icon (though it can 

be represented by any icon). The students can 
easily produce a variety of diagrams using the 
LOGO language. They will also write procedures 
using Random.

ADDITIONAL CLASS ACTIVITy FOR GIFTED STUDENTS OR SLOW LEARNERS

ACTIVITY 6.1:	 Give Some MSW LOGO Primitives, their Purpose and Short Versions (if any)

In groups, the students will prepare a table of some MSW LOGO primitives, their purpose and short versions 
(if any) and explain these in the class.

	 Table 6.1 gives some MSW LOGO primitives, their purpose and short versions.

Table 6.1: MSW Logo Commands (Primitives)

LOGO Command Purpose Short Version

FORWARD 50 Turtle moves forward the specified number of units. FD 50

BACK 100 Turtle moves back the specified number of units. BK 100

RIGHT 45 Turtle turns clockwise the number of degrees specified. RT 45

LEFT 90 Turtle turns counterclockwise the angle specified. LT 90

PENUP Turtle’s pen is up. (Does not draw as it moves.) PU

PENDOWN Turtle’s pen is in the down position. PD

PENERASE Turtle erases as it moves. PE

HIDETURTLE Removes the Turtle ‘triangle’ from the screen. HT

SHOWTURTLE Makes the Turtle visible again. ST

CLEARSCREEN Erases the screen and returns the Turtle to its “home” position 
in the centre of the drawing screen.

CS

HOME Returns the Turtle to the “home” position without erasing 
the screen. (Issue a PU command before HOME to prevent it 
drawing its return path as it goes.)

HOME

BYE Exits MSW Logo BYE

Fill in the Blanks

	 1.	 Seymour Papert
	 2.	 Turtle
	 3.	 FD or FORWARD
	 4.	 LT or LEFT

State Whether True or False

	 1.	 True	 2.	 True	 3.	 False	 4.	 True

Multiple Choice Questions

	 1.	 (a)	 2.	 (d)	 3.	 (b)	 4.	 (b)

Answers to Review Questions
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Match the Following

	 1.	 (d)	 2.	 (c)
	 3.	 (b)	 4.	 (a)

Answer the Following

	 1.	 	LOGO (Logic Oriented, Graphics Oriented) is a 
high level programming language specifically 

designed for its ease of use and graphics 
capabilities. LOGO was developed in 1967 by 
Seymour Papert and a team at Massachusetts 
Institute of Technology (MIT) in United States.

	 2.	 The LOGO window is labeled as shown below:

	 		 	 	

	 3.	 LOGO Primitives: LOGO commands are known 
as the ‘Primitives’. The primitives are typed in 
the white space at the bottom left corner of the 
screen known as the Command Input Box. For 
example, FD, BK, RT, LT, BYE etc.

		  Four LOGO primitives to draw shapes are 
explained below:

	 (i)	 Forward (FD): The FD primitive moves the 
turtle in the forward direction with the 
number of steps mentioned with the primitive. 
The turtle draws a line while moving. For 
example, to draw a line of 100 steps type the 
following command in the Command Input 
Box and press the Enter key: 

			   FD 100 

			   or 

	 	 	   FORWARD 100
	 (ii)	 Back (BK): The BK primitive moves the turtle 

in the backward direction (where it has its 
back) and draws a line of specified number of 
steps. For example, to draw a line of 60 steps 

in backward direction, type the following 
command in the Command Input Box and 
press the Enter key:

			   BK 60 
			   or 
	 	 	   BACK 60
	 (iii)	 Right (RT): The RT primitive turns the Turtle in 

right or clockwise direction. It needs number of 
degree to know the angle of turn. For example, 
to turn the Turtle in right direction by 90 degrees, 
type the following command in the Command 
Input Box and press the Enter key:

                RT 90
	 (iv)	 Left (LT): The LT primitive turns the Turtle 

in left or anti-clockwise direction. It needs 
number of degree to know the angle of turn. 
For example, to turn the Turtle in left direction 
by 90 degrees, type the following command in 
the Command Input Box and press the Enter 
key:

			   LT 90
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	 4.	 The following procedure draws circles randomly 
using RANDOM command. 

		  TO DRAWCIR 
		  ; Procedure DRAWCIR to draw circles
			   CS    ; Clear Screen 

			   REPEAT 5 [CIRCLE RANDOM 80] 
			   HT    ; Hide Turtle 
		E  ND

Suggested Activities

	 Refer to sub-unit 6.1 of the Student Textbook for 
doing Activities 1 and 3.

ACTIVITY 2:	W rite a Procedure to Include a Random Number Generator e.g., Throwing a 
Die

Students in their class will write and explain the procedure to include a random number generator, e.g., throwing 
a die (a small cube having numbers 1 to 6 on its faces).

	 TO RANDNUM
		 ; Procedure RANDNUM to generate a number randomly 
           CS ; Clear Screen 
           ; Show random nonnegative integer less than 7
           ; Ignore 0 as a die has numbers from 1 to 6
           Print RANDOM 7
    END

ALTERNATIVE TEACHING APPROACHES, 
ENRICHMENT MATERIAL
The ICT teachers can use Internet, charts, worksheets, 
models, and subject experts can be called for seminars 
to enrich the teaching level and in turn help the students 
in learning “Control and learning with LOGO”.

Additional Questions
	 1.	 What is the use of LOGO language?
	 2.	 Who developed LOGO and when?

	 3.	 Write a short note on the following LOGO 
primitives:

	 (i)	 FD	 (ii)	 RT	 (iii)	CS	 (iv)	PU
	 4.	 Draw an equilateral triangle of side 200 steps, 

using the LOGO primitives.
	 5.	 Write a LOGO procedure to draw a square of 70 

steps using REPEAT.
	 6.	 What is the extension of LOGO files?
	 7.	 Write a LOGO procedure to draw the following 

figure:
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Grade 9 
Minimum Learning Competencies (MLCs)

S.No. Units Minimum Learning Competencies
1. Introduction to ICT Define data and information•	

Explain the term technology and information technology•	
List sources of information•	
List computers generation •	
Compare the difference among each generation of •	
computers
Classify types of computers used today•	
List the characteristics of computer each type of computer•	
Explain  how data is represented in the computer•	
List major hardware components•	
Classify software as Systems or Applications software•	
Give examples and explain uses of some Applications •	
software
Manipulate their files and folders on a computer •	
Transfers files from one folder to another•	
Find a file or folders using a ‘search’ facility•	
Customize their computer desktop•	

2. Application Software Create and save  the word processing document•	
Format a character as required •	
Index a paragraph •	
Index  text in desired direction •	
Align text by using icons on the menu bar and by selecting •	
paragraph from formatting  menu
Apply bullets and numbers to display ordered or unordered •	
list
Change the styles of bullets and numbers effectively•	
Insert and delete a page break and page number in a •	
document
Add and delete headers and footers in a document•	
Use tables and pictures by inserting•	
Create a presentation•	
Prepare and present a slide show•	
Create a presentation using design techniques•	
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S.No. Units Minimum Learning Competencies
3. Information and Computer 

Security
Identify responsible behaviour in the computer laboratory•	
Identify safe online behaviour•	
Identify the school ICT policy and live with it•	
Describe computer virus•	
Identify the measure to protect computer virus•	

4. Application Software Identify the purpose of a spreadsheet•	
Identify the screen elements in the spreadsheet window•	
Manipulate rows and columns•	
Manipulate data in a cell•	
Save the worksheet•	
Use auto sum•	
Use mathematical operators on data to perform addition, •	
sum and others
Use the function of the Fill handle•	
Apply different effects to a cell and its contents•	

5. Using Internet Identify the internet and the world wide web •	
Explain how Internet and WWW are used•	
List and describe some different types of browser•	
Open a browser and identify the screen elements•	
Use web addresses to access websites•	
d•	 escribe some different types of browser
c•	 reate an e-mail account
Compose and send an e-mail•	
Receive and open an e-mail•	
Use the facilities provided in the e-mail system•	

6. Control and Learning with 
logo

Use the •	 logo primitives  to draw a variety of shapes
Write procedures to include  repeat and RND•	
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Grade 9 SYLLABUS

INTRODUCTION

In the long term, the students entering Grade 9 will have good practical IT skills.  They will be familiar with 
the major facilities of the most widely used applications, and be able to decide which application to use to fit 
a certain purpose. 

	 In Grade 9, the students will briefly cover the development of computers and communications technology.  
Then they will study three areas in greater depth: desktop publishing, database application and finally networks 
and communications.  By the end of Grade 9, students will be able to use a desktop publishing package effectively 
to produce a variety of documents such as brochures, visiting cards and newsletters.  

	 In Grade 10, they will continue the work on databases and will be able to interrogate a database and produce 
reports.

	 The assessments for both Grades 9 and 10 will be more complex and longer than previous assessments, and 
they will require more time spent in the computer laboratory.  

	 After finishing Grade 10 the students will take the National Examinations.  Those who pass the examination 
will either join a Preparatory School or will follow the Technical and Vocational stream of their choice.  This 
could be Information Technology.   In either case, students who have completed Grade 10 will have excellent 
IT skills which will serve them well in their future studies.

	 In the short term, the Grade 9 syllabus will be taught in the first year of implementation, followed by the 
Grade 10 syllabus a year later.  After 4 years, new Grade 9 students will have covered Grades 5–8.
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 c
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 d
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at
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 d
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 c
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 c
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 b

ar
, 

M
en

u 
ba

r, 
Fo

rm
ul

a 
ba

r, 
St

an
da

rd
 t

oo
lb

ar
, 

W
or

ks
he

et
, 

In
se

rt
in
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GLOSSARY

a

 Absolute Reference: Commonly used in 
spreadsheet applications, it is a formulated cell 
reference that will not adjust when used to calculate 
the sum of specific cells.
 AI (Artificial Intelligence): It is the branch of 
computer science concerned with making computers 
behave like humans.
 Analog: It is any fluctuating, evolving, or 
continually changing process that represents data by 
measurement of a continuous physical variable. 
 Application Software: A program that is designed 
to perform specific tasks.
 ASCII: American Standard Code for Information 
Interchange. It is pronounced (as-kee).

b

 Backup: To copy files or data to a second source or 
media so as to safeguard it. 
 Bandwidth: A measurement of how much data 
(bits per second) can be sent through a connection.
 BCD: Binary Coded Decimal.
 BIT (Binary DigIT): It is the smallest unit of 
processing of computerized data in terms of 1s 
or 0s.
 Blog: (Slang term for a Weblog) A blog is a personal 
journal that can be accessed publicly and allow people 
to comment on the previously posted comments. 
 BMP (pronounced “bimp”): Microsoft Windows 
image file format is the only graphics format where 
compression actually enlarges the file.  
 Byte: A combination of 8 bits to represent computer 
data transfer or data storage measurement. 

c

 Cell: Intersection of a row and column in a 
worksheet.
 CD-RoM (Compact Disc Read-only Memory): 
A durable and low cost circular optical storage device 
widely used to store large amounts of information.
 Computer: A computer is an electronic device 
that accepts, process, stores and outputs data under 
the control of a set of instructions.
 CPU (Central Processing Unit): A processor on 
an IC chip (called a microprocessor) that serves as the 
‘brain’ of the computer. 
 Cursor: A movable, blinking symbol that indicates 
the position on a computer screen where user action 
is needed.

d

 Data: A collection of raw facts and figures or a 
raw input which when processed or arranged makes 
meaningful output.
 Data Communications: The moving or sharing 
of encoded information between two or more data 
sources using an electronic medium.
 Digital: A system that defines data in a discrete, 
non-fluctuating (i.e., non-analogue), numerical digits, 
specially 1s or 0s.  
 Directory:  An organizing unit in a computer’s file 
system for storing and locating files. In a hierarchical 
file system, directories can contain subdirectories as 
well as files.
 Distribution List: Also called a mailing list, is 
a collection of e-mail addresses that allows you to 
e-mail multiple people at one time.
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	 Domain Name System: An addressing system 
in which abbreviations are used to indicate the type 
of organization or entity instead of whole name, for 
example, .edu for educational institution.
	 DVD: Digital Versatile Disc or Digital Video Disc.

E

	 E-Commerce: Buying and selling or business 
transaction conducted on the Internet.
	 E-Mail: Stands for Electronic Mail. This is a system 
of relaying messages across the Internet, from one 
Internet user to another.
	 EPROM: Erasable Programmable Read-Only 
Memory (“ee-prom”). It is a memory chip whose 
contents can be erased by a mechanism using ultraviolet 
light and reprogrammed for other purposes.

F

	 Firmware: A microprogram stored in read-only 
memory (ROM), designed to implement a function 
that had previously been provided in software.
	 Format: The arrangement of data for computer 
input or output, such as the number and size of 
fields in a record or the spacing and punctuation of 
information in a report. It is also used to prepare a 
disk for reading and writing.
	 Freeware: This is a shortened version of Free 
Software. Programmers offer their work without 
wanting pay in return.
	 FTP (File Transfer Protocol): A software protocol 
for exchanging information between computers over a 
network.

G

	 Gigabyte (GB): 2 to the 30th power (1,073,741,824) 
bytes. One gigabyte is equal to 1,024 megabytes. 
	 GIGO: It is an acronym that stands for Garbage In, 
Garbage Out.
	 GUI (Graphical User Interface): A program 
interface that takes advantage of the computer’s 
graphics capabilities to make the program easier to 
use. Well-designed graphical user interfaces can free 
the user from learning complex command languages.

H

	 Hardware: The physical equipment used in a 
computer system, such as the CPU, peripheral devices 
and memory.
	 Home Page: The initial page of a site on the World 
Wide Web.
	 HTML: Hypertext Markup Language. It is a 
collection of structuring and formatting tags used to 
create Web pages.
	 HTTP (Hyper Text Transport Protocol): The 
standard protocol for transferring hypertext documents 
on the World Wide Web. 
	 Hyperlinks: A word or graphic display on one 
web page that allows a computer to shift to another 
related web page.
	 Hypertext: A method of storing data through a 
computer program that allows a user to create and 
link fields of information at will and to retrieve the 
data non-sequentially.

I

	 Icon: A picture or symbol to represent a command 
on a computer screen.
	 ICT: Information and Communication Technology.
	 IDE (Integrated Development Environment): 
A programming environment integrated into an 
application.
	 Information: Meaningfully organized data.
	 IT (Information Technology): The development, 
implementation, and maintenance of computer 
hardware and software systems to organize and 
communicate information electronically.
	 Integrated Circuit (IC): A circuit of transistors, 
resistors, and capacitors constructed on a single 
semiconductor wafer or chip, in which the components 
are interconnected to perform a given function.
	 Interpreter: It translates and executes source 
program, written in high level language, statement-
by-statement.
	 Internet: The Internet is a network of networks 
all of which use the same set of communications 
protocols. 
	 Intranet: A private network for communications 
and sharing of information that, like the Internet, is 
based on TCP/IP but is accessible only to authorized 
users within an organization. An organization’s 
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intranet is usually protected from external access by a 
firewall.
	 ISP (Internet Service Provider): A company that 
provides access to the Internet.

J

	 JAVA: A high-level programming language 
developed by Sun Microsystems.
	 JPEG (pronounced “J-Peg”, stands for Joint 
Photographic Experts Group): It is an image format 
that allows for compression when stored.

K

	 Kilobyte (KB): This is about a thousand bytes of 
space. In reality, it is two to the 10th power or 1,024 
bytes.

L

	 LAN (Local Area Network): A network that 
links together computers and peripheral equipment 
within a limited area, such as a building or a group of 
buildings.
	 Language Processor: Software that converts a 
high level language or assembly language code into 
machine understandable form.
	 LCD (Liquid Crystal Display): A method of 
displaying readings continuously using a liquid-
crystal film, sealed between glass plates that changes 
its optical properties when a voltage is applied.
	 Login: To attach to a computer using the user’s 
ID.
	 LOGO (Logic Oriented, Graphics Oriented): A 
high level programming language specifically designed 
for its ease of use and graphics capabilities. 

M

	 Mainframe: Second largest computer available 
after the supercomputer.
	 Megabyte (MB): About a million bytes of space. 
Actually it is 2 raised to the 20th power or 1,048,576 
bytes of space.
	 Memory: Internal storage areas in the computer.
	 Microcomputer: A category of computer that is 
generally used for personal computing, for small 
business computing, and as a workstation attached 

to large computers or to other small computers on a 
network.
	 Microprocessor: An integrated computer circuit 
that performs all the functions of a CPU.
	 MODEM: Stands for MOdulator and DEModulator. 
It is a device that changes data from digital (computer 
language) to analog (phone line language) and then 
back again.
	 Motherboard: The main circuit board of a 
microcomputer.
	 MPEG (Motion Picture Experts Group): A format 
to make, view, and transfer both digital audio and 
digital video files.
	 MS-Excel: Spreadsheet application software, 
provided by Microsoft.
	 MS-PowerPoint: Presentation software, provided 
by Microsoft.
	 MS-Word: Word processing application software, 
provided by Microsoft.

N

	 Nanosecond: A billionth of a second. Many 
computer operations, such as the speed of memory 
chips, are measured in nanoseconds. Nanosecond is 
often abbreviated as ns.
	 Netiquette: The rules of etiquette that apply when 
communicating over computer networks, especially 
the Internet. 
	 Newsgroup: An online discussion community found 
on the USENET system. These groups cover thousands 
of different topics of information and are offered free of 
charge.
	 Node: In networks, a processing location. A node 
can be a computer or some other device, such as a 
printer.

O

	 Operating System: A system software program 
that works as a bridge between computer hardware 
and the user. Operating systems perform basic tasks, 
such as recognizing input from the keyboard, sending 
output to the display screen, keeping track of files 
and directories on the disk, and controlling peripheral 
devices such as disk drives and printers. 
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	 Output Device: A device that translates information 
processed by the computer into a form that humans 
can understand.

P

	 PDF (Portable Document Format): A technology 
developed by Adobe and was designed to capture all 
of the elements of a printed document and place it in 
a single image file.
	 Pen Drive: A secondary storage device that can be 
used to easily transfer files between USB-compatible 
systems.
	 Pixel: The smallest element of an image that can be 
individually processed in a video display system.
	 Plotter: A computer output device that draws 
images on paper using a pen.
	 Primitives: The LOGO commands are known as 
‘Primitives’.
	 Procedure: The sequence of actions or instructions 
to be followed in solving a problem or accomplishing 
a task. It may be used at one or more points in a 
computer program.
	 Processor: A device that processes programmed 
instructions and performs tasks. The speed at which 
the CPU processes information internally is measured 
in MegaHertz (MHz) and GigaHertz (GHz). 1 GHz is 
equal to 1,000 MHz.
	 Programmable Read-Only Memory (PROM): 
A special memory chip that is blank when first 
purchased. It can be written to by the user by using a 
special hardware program. Once the data is written to 
it, it cannot be erased or changed.
	 Protocol: A set of rules governing the format of 
messages that are exchanged between computers.

Q

	 Query: Used to retrieve information on a certain 
condition from a database.

R

	 RAM (Random Access Memory): A volatile 
computer memory available to the user for the 
temporary storage and manipulation of data. 
	 Relative Reference: The default reference in a 
spreadsheet package.

	 ROM (Read-Only Memory): A memory in which 
program instructions, operating procedures, or other 
data are permanently stored, generally on electronic 
chips during manufacture, and that ordinarily cannot 
be changed by the user or when power is switched 
off.
	 Router: A device in a network that handles message 
transfers between computers. 

S

	 Scroll Bar: A widget found in graphical user 
interface and used to show and control which portion 
of a document is currently visible in a window. A 
window may have a horizontal or, vertical scroll bar, 
or both.
	 Screen Saver:  A moving picture or pattern that 
appears on the screen when you have not used the 
mouse or keyboard for a specified period of time.
	 Serial Port: A port or interface that can be used for 
serial communication, in which only 1 bit is transmitted 
at a time. Most serial ports on personal computers 
conform to the RS-232C or RS-422 standards.
	 Server: This is a mainframe computer that serves 
the other computers attached to it.
	 Sheet Tab: In spreadsheet applications, this refers 
to a tab at the bottom of a worksheet that acts as a 
means to identify or access different sheets within a 
workbook.
	 Slide Show: Used to display the slides in a desired 
sequence.
	 SMS (Short Message Service): A popular wireless 
service that is used for sending and receiving short 
messages up to a maximum of 160 characters. The 
service is used for text messaging between cell 
phones that are on a GSM (Global System for Mobile) 
network.
	 Source Code: Program code written in a high level 
language.
	 Software: The set of instructions used to direct 
the operation of a computer, as well a documentation 
giving instructions on how to use them.
	 Spam: The disruptive unwanted messages, 
especially commercial messages posted on a computer 
network or sent as e-mail.
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	 Spreadsheet: A document which helps to organize 
data in rows and columns that intersect to form cells.
	 Supercomputer: High-capacity computer with 
thousands of processors that is the fastest calculating 
device ever invented.
	 Switch: In networks, a device that filters and 
forwards packets between LAN segments.
	 System: A combination of the hardware, software, 
and firmware. A system typically consists of components 
(or elements) which are connected together in order to 
accomplish a specific function or set of functions.
	 System Software: It is a set of master programs 
that keeps the computer system working. 

T

	 Task bar: The bar that contains the start button 
and appears by default at the bottom of the desktop.
	 TCP/IP: Acronym for Transmission Control 
Protocol/Internet Protocol, the suite of communications 
protocols used to connect hosts on the Internet.
	 Terabyte (TB): 2 to the 40th power (1,099,511,627,776) 
bytes.
	 Toolbar: A row or rows of buttons on a display 
screen that are clicked on to select various functions 
in a software application or web browser.
	 Topology: In networking, this refers to the physical 
or logical arrangement of a network.
	 Trojan: A type of computer virus that is loaded 
into an unsuspecting users system via a host program 
such as a free game.
	 Turtle: A triangular shape pointer used in LOGO 
that helps in drawing figures.

U

	 UNICODE: Binary coding scheme that uses 2 
bytes (16 bits) for each character. It allows almost all 
the written languages of the world to be represented 
using a single character set.
	 Uploading: It means transmitting data from a local 
computer to a remote computer, as from your PC to a 
website you are constructing.
	 UPS (Uninterruptible Power Supply): It is a 
backup power unit that provides continuous power 
when the normal power supply is interrupted.
	 User: Someone attached to a server or host.

	 Utility Program: A program developed to run 
within an Operating System to perform a specific 
service.

V

	 Virus: A program or piece of code that is loaded 
onto your computer without your knowledge and 
runs against your wishes.

W

	 WAN (Wide Area Network): A network in 
which computers are connected to each other over 
a long distance, using telephone lines and satellite 
communications.
	 WAV: Stands for WAVeform sound format. 
Microsoft’s format for encoding sound files.
	 Web page: A single, usually hypertext document 
on the World Wide Web that can incorporate text, 
graphics, sounds, etc.
	 Web server: A computer that runs specific software 
to serve web pages to the Internet.
	 Website: A connected group of pages on the 
World Wide Web regarded as a single entity, usually 
maintained by one person or organization and 
developed to a single topic or several closely related 
topics.
	 Wizard: A utility that provides guided sequence to 
perform complex task easily and quickly.
	 Word Processor: Software that processes textual 
matter and creates organized documents.
	 WWW (World Wide Web): Series of servers or 
computers that are interconnected through hypertext.
	 WYSIWYG: What You Say Is What You Get.

X

	 XML (eXtensible Markup Language): It is a 
markup language, not limited to Web documents.

Z

	 Zip Disks: The disks with a special high-quality 
magnetic coating that have a capacity of 100, 250 or 
750 megabytes.
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